You are here: Report Wizard > Selecting Fields

OVISION

GOVERNMENT SOLUTIONS

Selecting Fields

The purpose of this document is to assist the user with creating an ad-hoc report using Vision’s Report
Wizard.

1. Start by clicking Reports in the navigation tree on the left-hand side of the screen.

) Parcel ;

Owner Maintenance :
ET&;@N ;
Comps & Apportionment A
Cost Modeling ;
e ecwe s sui L2 =

On the main Report Wizard page, a list of TABLES will be visible.
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2. Click on the plus sign ¥ icon that appears next to the table you would like to include in
your report to view fields available within that table.

R

Table Name _ ‘
PARCEL EXTENSION
@  REAL OWNERSHIP i

REALMAST !

IMAGES r

+ SALEHIST g

@  SUBAREA
®  VISITHST !
@  CURRENT OWNER AN /
Preview Report Output :
I TN

3. Then, click on the boxes to select the individual fields to be displayed on your report.
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Table Name :
Include  Filter Only Column Name Sample
REM_ACCT_IDX
REM_ACCT_NUM - 10020301
REM_ALT_PRCL ID 0000 ?002030?;
REM_ASSOC_PARCEL_ID (
REM_ASSOC_PCT
REM_BLDG_NAME
REM_CARD_QUEUE r

———
Preview Report Output . - ... . ., .-G By Levels: - - ¢

4. An option to select field alignment is also available by clicking the Alignment dropdown
and selecting Left, Center or Right.

T e ?‘.IIIIU;. - - = — == ; = = = =
lrchody Filer Oty o Mame P Fretn Fimae A ginitiend Favmad Farwilitm
REM ALY, (0K
> M ALCT M ‘ oo
RER ALT P (1] A LRGN
A ASSOW PaRTEL T
B ASUN T
AL
ARl Okl
Pywareis Rapart Owiput Geoup By bawsin ! : [

5. For any numeric fields, the user may choose a number format by clicking the Format
dropdown.

In the example below, we selected a currency format for the Total Appraised Value field.
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6. Asyou select fields, a preview of your report will display on the bottom half of the
screen under Preview Report Output.
Preview Report Output Group By Levels: v
REM_PID | REM_ACCT NUM REM_PRCL LOCN : REM_OWN_NAME PRC_TTL_ASSESS /
1 10020301 1 N MAIN ST ST W UNIT $420,600 .
2 10020302 2 N MAIN ST ST W UNIT  MICHAEL MILLER  $420.600 I
3 10020303 I NMAIN $T ST W UNIT $420,600 “
4 10020304 4 N MAIN ST W $420,600
1
5 10020308 5 N MAIN STW $420,600 g
6 10020306 5 N MAIN ST ST W UNIT $420,600 '
7 10020307 7 N MAIN ST W $420,600 f
B 10020308 B M MAIN ST W $253.000 ;
9 10020309 O M MAINSTW $253.000 J
e — - —r - - - —_

7. Once you have all of your fields selected, you may change the order of the columns by
single left-clicking on the column header and dragging the column to the desired area.

First, click on the column header to be moved and hold the left mouse button down.
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Preview Report Output

Group By Levels: | vis
REM_PID 'REM_ACCT_NUM 'REM_PRCL_LOCN REM_OWN_NAME ~ | PRC_TTL_ASSESS ;
2 10020302 2 N MAIN ST STW UNIT  MICHA $420,600 |
1 10020301 1 N MAIN 5T ST W UNIT E@ $420,600 ‘
3 10020303 3 N MAIN ST ST W UNIT $420,600 {
4 10020304 4 N MAIN STW $420,600 ;
5 10020305 5 N MAIN STW $420,600
6 10020306 6 N MAIN ST ST W UNIT $420,600 ¢
7 10020307 7NMAINSTW $420,600
8 10020308 B N MAIN ST W $253,000
9 10020309 9 N MAIN STW $253,000 A
B il ST O DR P o G P I AAE T &
Next, while still holding the left mouse button down, drag the selected column to the
desired location. The location will be indicated by black arrows.
Preview Report Output ) Group By Levels: .
'REM_PID REM_ACCT. NUM RENPROL LOCN REM_OWN_NAME ~ PRC_TTL_ASSESS i
2 10020302 y2NMAINSTSTWUNIT MICHAELMILER  $420600 !
1 10020301 1N MAIN ST STW UNIT $420,600 r
3 10020303 3 N MAIN ST ST W UNIT $420,600
4 10020304 AN MAINSTW $420,600 /
5 10020305 5 N MAIN STW $420,600 ;
6 10020306 6 N MAIN ST ST W UNIT $420,600 ;
7 10020307 7N MAIN STW $420,600
8 10020308 8 N MAIN ST W $253,000 i
9 10020309 9N MAIN STW $253,000 ‘
RN N e R e S I R N e e

Release the left mouse button once the column has reached the desired location. The
report columns will be reordered.
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Preview Report Output

Group By Levels: |

| REM_PID  REM _ACCT_MUM REM_OWN_NAME = REM_PRCLLOCN PRC_TTL_ASSESS
2 10020302 MICHAEL MILLER 2 N MAIN 5T ST W UNIT $420,600
1 10020301 1 N MAIN ST ST W UNIT $420,600
3 10020303 3 N MAIN ST ST W UNIT $420,600
4 10020304 4 NMAINSTW $420.600
$ 10020305 5 N MAIN ST W $420,600
& 10020306 6 N MAIN 5T STW UNIT $420.600
7 10020307 T N MAIM ST W §420,600
8 10020308 8N MAINSTW $253,000
) 10020309 INMAINSTW $253,000

R N T

Beves bypon Lutps

8. Once all of your fields are added and in the desired order on your report, add a Title to

your report and click Next to view your completed report.
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9. The report results will now display.
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| Report
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HEM =)

10020301 1HMAIN STW $4720,600

2 10020302 MICHAEL MILLER 2N MAIN ST ST W UNIT $420,600
3 10020303 31 MAIN ST W 420,600 .
4 10020304 ANMAN STW $420,600 -

| 5 10020308 5 N MAIN ST W $420.600

| § 10020306 § N MAIN ST ST W UNIT $420,600 -
? 10020307 TN MAIN STW $420,600 °

.' 8 10020308 B N MAIN ST W $263,000 ¢

, 9 10020309 9N MAIN ST W $253,000 °

i 10 100203010 10 N MAIN STW 5253000

" 100203011 11N MAIN ST W £263 000 7

P i

e
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You are here: Report Wizard > Grouping Data

OVISION

GOVERNMENT SOLUTIONS

Grouping Data

The purpose of this document is to assist the user in organizing results in the Report Wizard. Report Wizard allows the
user to create their own “customized” reports by selecting various TABLES, FIELDS, and SELECTION CRITERIA to adjust
the report to suit the requirements. That data can be organized using several method, including using the Group By
Levels function.

1. Navigate to the left-hand menu tree, and click on Reports

2. Inthe main Report Wizard page, a list of TABLES will be visible.
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3. Click on the plus sign ™ icon that appears next to the table you would like to include in your
report to view fields available within that table.

Preview Report Columnns and Data:

| Table Name
NOTES
NOTICEHIST
OBXF
OTHERASS
OVRADJ
PARCEL
REAL_OWNERSHIP
REALMAST
SALERIST
VISITHST

® @ 8 8 8 & 8

- +
?"

®

4. Click on the boxes to select the individual fields to be displayed on your report.

Preview Report Columns and Data:

Table Name
2 REALMAST
Include | Column Name | Sample
"» REM_ACCT_NUM 13-3506-37

REM_ALT_PRCL ID
REM_ASSOC_PARCEL_ID
REM_ASSOC_PCT
REM_BLDG_NAME
REM_CRCSS_STREET 1
REM_CROSS_STREET 2
REM_FIELD_REVIEW 0

5. An option to select field alignment is also available by clicking the Alignment dropdown and
selecting Left, Center or Right.
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Preview Repaet Columes snd Data ]

Table Name s

Include | Calumn Name Sempie  Formula | Fatbar Abgrvnent | Format
REM_MBLU_UNTT -
REM_MBLU_UNIT (U1 '
REM_MNC $41% - J

' 7 REM_OWN KAME MURPHY PASHA M
REM_PARCEL_STATUS A -
v REM_FID i v

REM_PIN
REM_PRCL ID 1 v
REM PRCLLOCN 75 SMITH avE T ‘

6. For any numeric fields, the user may choose a number format by clicking the Format dropdown.

In the example below, we selected a currency format for the Total Appraised Value field.

0 . "
225000 - - v
Sl ST T EPUIPTRER ¥ R S - ] g::q;_ —. j
9200
0
L : 000 .
225000 . . oo !
» o). 00 '
(+} L4 e L1 I
NO_AKESA ACES (45200000 . « |MNdayy
My
PRC_TTL KRGRESIION o . * | WMddyy Nermmss
. 0.000 o
Proview Rapent Output Growp Oy Lowel: I ] 00000
D oo m ol =T e e e — , 1o L
REM_PID ~ REMACCT NUM | BEM_PRCLLOCN  RC_TTILASSESS 'omacooucna
0 2-1 70004 33 SMATH AVE 4245 0 {129
1 5 i Dags
] 23-1014 00 31 SMITH AVE 1408
$ C(! 0.000%
] 15084800 89 SMITH AVE  $248 300 00000%
L] 19-2616-00 5 FANMINGG LAt §17% 700
- 10-0h11-90 87 SMITH AVE $155 BoC
Bl reess MINOIPEAD cesi BB MITM AVE - BlEDAD o
1 8- 1806-12 79 SMATH &VE $22% pOD
e 130114 27 5MATH AVE iy g
0 19-137% 25 8 FARMNING Lah] $283.400
i 13-3%8& 37 T3 SMITH AVE 1215000
7. As you select fields, a preview of your report will display on the bottom half of the screen under
Preview Report Output.
P LR G o T —— (3
Fihe Ml 00 ACEY SR M IO |0 b Pima Chumih | I ey L0CM SOREET M CuNR fedl
| N NN ol AR vt (LT T
2 LIR30 ” b arE MACHAY AT KT £ Un
\ e ) M it AT ANAHIE
4 oA a% ST AVE e AL MOVOCANE el y TRLT
] P 3= R 4z MITH AvE Leals o oLl
L] (L RER - % PANMDOL LANE Adadkr Mpih o
] - Suk v RO P dehbad | 01
L] mn HTH A WA Lin Do &
L] 3t SMHYH Ak
1o 5 AN AN

8. Click on the drop box Group By Levels to group the report results. These levels are not the
column numbers, just the number of time a report grouping can be defined.
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Preview Report Output Group By Levels: v

Repont

©

Group

1

Papvars Fepnt Ouirsd Group By Levets TER AsGSLD VALLES

REM_PRCI_ID 'REM_ACCT_NUM REM_PRCL_LOCN rm]' L T2

i 10020301 { N MAIN ST ST W UNIT

2 10020302 2N MAINSTSTW UNIT MIf |

3 10020303 INMAINSTSTWUNT |,

4 10020304 4N MAIN STW 5

5 AR L vy wsaagy o ATNERS

9. Choose the number of levels you wish the report to be grouped, give the report a title, and click
the Next button in the lower right-hand corner of the page. (In this instance, the report will only
be grouped by 1 level).

[
T IRLRO WA AN MARO LN Mo ety S T !
P TR SAAN ST 37 W UNIT ' <- 2 "
AN 2% MR BT 37 W Gkt :
P AL SN 5 S W l)
) ek A% WA 5 W

! Thas kS N WA TN R I ;

| V) 2050 £0MAN 47 57 W RIT VAN AT 40 },

| T 7% MUK §T W MY MRLER e

' NG i A 5w NICHALL MKLER 283F L

| TN 30 MK ST W KOCHATL MMLLEL 28300 !

| el 1 5 NS N ST & AHCAME MLLER 500 .'
. . | E— i

X =

10. The parcel information will appear. In this instance, the information is grouped by PID, as
indicated in the Group 1 indicator box.

Wizard
1 fremro - I
of 21 » A P adude 00 v DEng Mear
ASSESSED VALUES

T H MAIN §T'W IMCHALL MILLER

2 2 10020302 2 N MAIN ST ST W UNT MICHAEL HILLER 420500

3 ) 10020303 3% MAIN BT W MICHAEL WILLER 20620

* By using the drop-box next to the field name, a user can adjust the grouping based upon the
tables originally selected.
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11. Select the field by which you wish to group the information, and click on the View Report button
in the upper right-hand section of the page. Here the field PRC_TTL_ASSESS is selected.

Rupar Wand
w
. H'I‘I:‘:'LII Azt =) I—@>M‘
s ::::::"":‘ [N PR DTN . ' -
CWELAALE! 1 ASSESSED VALUES

12. The report now displays grouped by the PRC_TTL_ASSESS values (in the image, Zero values are
grouped together followed by 95,000, 126,900, etc.)

Report Wizard
0 s

Geroup 1 [pRC_TTLASSESS v)

WA ef e e m e GAUR W% - | | Foa o Nen
ASSESSED VALUES

REM ACK N WH

28 0203024 26 N MAIN ST W MICHAEL MILLER
27 100203027 TN MAIN ST W MICHAEL MLLER

| 95000 k4 100203032 32N MAIN ST ST'W unIm MICHAEL MILLER 95000

|I 95000 n 100203033 33 H MAIN ST W MICHAEL MALER 95000

95000 M 100203034 34 1 MAIH ST W MICHAEL MLLER 95000
‘ 95000 kL) 100203034 35 N MAIN ST W MICHAEL MILLER 95000
| 35000 % 100203036 35 N MAIN ST W MICHAEL MELER 95000

’ 128900 2 00203022 ZHMAN STWA MICHAEL MLLER 126500
| 126800 23 100293023 23 N MAIN ST ST W UNIT A MICHAEL MILLER 126900
| 126800 M 100203024 3N MARN STWA MICHAEL MRLER 126500
!

126900 2% 100203025 25 N MAIN ST WA MICHAEL MILLER 126900

By scrolling down to the bottom of the report, the user can see how many parcels are included in
the Grouped Report.

If the user wishes to re-group the report by a different field, or add more levels of grouping, simply
click the Back button to change the conditions of the report layout.
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13. Change the Grouping Level as desired and click Next
Previgw Ropar? Ondput Gaap By Lavels . Vi AELE[ VALLES
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i 4. el N A A e
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14. Select the fields by which you wish to group the information, and click on the View Report
button in the upper right-hand section of the page. In this case, PRCL_TTL_ASSESS, then
OWN_NAME]1, and finally, REM_ACCT_NUM

}‘—__:>[ e Bt
Groun 3 [REuPRCLIOEN v : - N
REWAFRCE D <_ I

y :;l‘:;ﬂ&ﬂ‘li\(ﬁ SR 35 PUR TR oY

LN MR NIE S ASSESSED VALUES

RC TTL ASSESS

15. The report will now display grouped by the previously selected fields:
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You are here: Report Wizard > Selection Criteria

OVISION

GOVERNMENT SOLUTIONS

Using Selection Criteria

The purpose of this document is to assist the user in modifying a report to target specific results through selection
criteria. Each criteria operator will be reviewed to explain how it can be used to limit data returned to the desired
information.

% % Before adding selection criteria to a report it is recommended to first add all of the fields to
be used. For assistance with this process, see the Selecting Fields document.

1. The first example will be using the Equals { =) operator. This report will be modified to
target parcels with a specific model code of 01 Residential.

2. Select the table containing the field for the selection criteria.

fii The CONSTR table contains the CNS_MDL field we will be using for this example.

b

Table Name 7
ASSHIST f
®  BLOG /
BLDGPERM /
® » CONSTR x
®  CONSTRCDM f
®  CONSTRCDU /
®  CONSTRCOM I
®  CONSTRDEP {

- = —p .
e - Nl i g o f -t

3. Click on the plus ¥ sign to expand the table and find the field CNS_MODEL (construction
model).
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Table Name

CONSTR
fude ' Filter Only | Column Name Sample Formula Filter Alignny
CNS_ALT CODE_} \ b 241 | |
CNS_ALT_CODE 2
CNS_ALT_COMPLETE 1 f
CNS_ALT_COMPLETE 2 :
CNS_ALT ISSUED 1
CNS_ALT ISSUED_2 ’
4. Scroll through the available fields until the desired field is located. To begin adding selection
criteria for the field concerned, double left-click on the filter column for this field.
Table Name
Inclyde Filter Only Column Name Sample Formuia Filter Aligni
Tl CNSISEXELPCT 100 1
P CNSIS_EXE2 0 «’
1 CNS_IS_EXE2_PCT 100 ’
¥ CNSIS_VACANT 0
- CNS_MDL o ;
b4 4l CNS_MDL_DESC Residential
# Tl CNS_MNC 99999 !
gt . e " e PO P LR N

The Report Wizard Filter box will appear.
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/Include  Operator

BETWEEN
LIKE

NOT LIKE

IN

NOTIN

IS NULL

IS NOT NULL

5. To utilize the = modifier, first check the Include box for the operator. Then enter the Value to
be targeted. Once this has been completed, click Save.

In this example we are only targeting parcels with a model code of 01.

Note: When using the = operator, the Value entered needs to exactly match how the data is
entered in the database. For example, if we entered only 1 instead of 01 using = as the
operator, no parcels with 01 model codes would return in the results.

BETWEEN

LIKE

NOT LIKE

iN

NOT IN

1S NULL

1S NOT NULL
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6. The custom selection criteria will then be displayed in the Filter column for the selected
field. Report results will now only include those parcel with a build that has a model code of

01.

1ol Name

nlisde Fatter Only’ Calumn Name Sermgle Formuda Filtes ’ Aligni
OGS IS ExEY T 160
PG 15 EMES o
N5 IS EXEZ PCT 100
CNS_IS_VACANT o

' el ORI e S e AR [constmons Mo - ov)

€8S ML _DESC Rensdental

RS MNC 99999

The next example will illustrate the Greater Than (>}, Less Than (<), Greater Than/Equal To
(>=), and Less Than/Equal To (<=) operators.

7. In the Report Wizard Filter box, left-click on the Include box to the left of the > operator.
Then, enter a value in the Value field. For example, we’ll search for parcels where the Model
is Greater Than (>) 94. Then, click Save to add the filter.

» s
i
1 |
M
Pk GR
i NI LIKE OR
oW TR
NOE SN [
Lo s wnL R

1% HOT UL R
©)]

Conversely, Less Than (<) could be used to target values smaller than 94 to get a different
selection.
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8. You may also use Greater Than/Equal To (>=) or Less Than/Equal To (<=} to include the
Value entered in the results. In the example below parcels with a total assessed value of
$10,000.00 or greater will be targeted.

inchade Operator

P OR

OR

el

- DR

is OR
BETWEEN Of !

LIKE oR

NOT LIKE OR

N OR
NOT IN oR '

15 NWLL OR

15 NOT MiLL R

Save Canced

9. The Greater Than/Equal To (>=) and Less Than/Equal To (<=) can be used together to create
arange. In the below example, parcels with a total assessed value of $10,000.00 and less
than $1,000,000.00 Will be targeted.

Note: When using multiple selection criteria for one field, change the AND/OR column
value to AND.
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BETWEEN
LIKE

NOT UKE
IN

NOT IN

=y
.

—
i

e

1

!

i

1§ NULL
15 NOT RULL

10. In some instances, we may want the operators to work separately. In the example below, the
selection criteria will narrow results to parcels with Land Use Code Greater Than/Equal To (>=) OR
Less Than/Equal To (<=) 94. Results would exclude any parcels that do not meet either of these two
criteria.

include Cperator Vake AND/OR
= OR
R
v = G6 R <;, i
. &R
f [ o e et el <
&R
PETWELH R
LE R
NOT UIKE OR
N R
REIT IN Of
15 ML K
5 ROT PelILY R

11. The next operator, Not Equal To {<>), is used to exclude one specific value. in the example
below, the Not Equal To (<>) operator is used with the Model field to exclude parcels within
Model 01.
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ANGAOR
of
oR
GR
oR
Ok
oR
OR

BETWEEN

URE R
| | ROT LiKE OR

il OR

NOT IN DR

15 N OR

IS NOT NULL R

12. The next operator, Between, is used to narrow results to parcels between two specific
values. To use the Between operator, left-click the box to activate the operator, then enter
the two values separated by a comma and no spaces. Then, click Save.

¢ In this example, we added criteria to the Actual Year Built field. This field is found in
the CONSTRDEP table and the field called CNS_AYB. The following criteria would
result in only parcels with an Actual Year Built between 1995 and 2005.

e | Opiwator Vaiue AXOOR
i1 = oR
1 R
Ll R
i R
{1 )
] e o
o s [T Jon
L wet ' o
T moTLEE A
[ s
Pl monin @
T s o8
L is fe0T NutL [l
Swe | | Conent

13. The next two operators, Like and Not Like, allow the user to use the symbol % as a wildcard.
This wild card will allow the results returned to be similar/dissimilar to the criteria entered.
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14. For example, using the Construction Model field, the selection below using the Like operator
would include any parcels with a Construction Model beginning with “0”.

Einuuae;'Opeulw

il e or
I OR
T1 e OR
1o oR
B OR
Ul e Of
[ ] BETWEEN o
S CCI—
] NOTLRE OR
Y OR
NOT 1M OR
s wauL OR
19 NOT AL QR

[Swe | [ Cancel |

15. In the next example, we used the Not Like operator, utilizing the % wildcard with the Owner Name
field, to exclude any parcels where the Owner Name field includes the word “CITY”. The Owner
Name field is located in the REALMAST table and the field name is REM_OWN_NAME.

inchude | Operator

] OR
o & |
71 <= OR
L oR
. OR '
£ e oR '
{1 BETWEEN OR }
1y % Like OR
SR T o — |
C1 N OR
[7 NDTIN OR i
Y OR |
T 1S NOTANULL oR

16. The In and Not In operators allow the user to select multiple values to either include or
exclude from their report. Similar to other operators, to use the In or Not In operator,
double-left click in the Filter column within the field to which you wish to add criteria.

17. Place a check in the box to activate the In operator, enter the value(s) to be included and
click Save. In this example, we only included parcels with a Construction model of 94, 95,
and 96.
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| BETWEEN
Y

[.1 WNOTLKE

1 ROTIN
% ML

1 NG NuLL

| Save | Cancel |

18. Similarly, the Not In operator can be used to exclude parcels with a Construction Model of

94, 95, and 96.

Hinchude  Dpovtorn Valve ANDVOR
it - O8]
OR
i e OR
i, oR
- R
- OR
T BETWELNM OR
O OR
T NOELKE O
PN OR

' s DTN - BAGROE - e OB i
L IsNUL R
T NOT N OR

[Sow | [Cancd)

19. The last two operators to filter field criteria are Is Null and Is Not Null. These two operators
simply narrow results based upon a specific field being Null (blank) or Not Null {populated
with a value). In this example, we will search for parcels where the Land Zone field is Null

20.

{blank).

Double left-click in the Filter area for the selected field; in this case, navigate to the LAND
table and select the LND_ZONE field, and simply check the box to activate the Is Null
operator, then click Save. No Value is required with the Is Null or Is Not Null operators.
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AND/OR
Of
® » I
OR
OR
OR
<> o
BETWEEN OR
LIKE oR
NOT LiKE OR
N OR
NOT IN OR
M sNuw OR
[ 1S NOT NULL
[ snve | [ Conce

Once the desired Selection Criteria are entered, the report can be viewed/saved by
following the instructions detailed in the document titled Report Wizard - Saving and
Opening Reports.
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You are here: Report Wizard > Navigating Results

O VISION

i
v

Navigating Results

This document will walk the user through manipulating the output of Reports created in Report Wizard
in Vision 8.

Once a report has been created and been previewed, there are multiple ways to sort and navigate
through the results. On the report preview screen, the following information will display:

¢ The information from the fields you selected for the parcels that fit the criteria.

¢ The report will be sorted as you indicated on the Select Tables and Columns
screen.

¢ The report will have the same headers, text alignment and title.

¢ On the last page, you will see a total parcel count and any formulated totals
(Sum, Average, Median, etc).
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Q 5
41 Jof 15 8 B A d- 100% - | | Find ' Next
APPRAISED VALUES
REM ACCTY 350t - B 5 S PR — W A « | FC FTL APPRAILS

10020301 N MAIN ST W 420580
100203610 10 1 MAIN ST W 262960
100203011 14 MAIN ST W 252960
100203012 12 1 MAIN 8T W 252950
100203013 13 1 MAIRE ST ST W UNIT MICHAEL MILLER 262960
100203614 14 M MAIMN ST ST W UNIT 252950
100203015 15 N MAIH ST W 252960
100203018 16t MAIM ST W 252960
100207617 17 H MAIN ST W 252960
100203018 18 N MAIM ST ST W UNIT #4 155080
100203019 19 H MAIN 5T W A 155080

10020302 21 MAIN ST ST W UNIT WCHAEL MILLER 420580
100203620 20 1 MARN ST W A 155080
100203821 21 M MAIN ST W A 155080
100203022 22 NOMAIN ST W A 126380
100203623 21 W MAIN ST ST W UNIT 9A, 126830

The report will indicate 1 of 2? pages. To see the actual number of pages, use the arrows at the
top to go forward or backward pages. The blue arrow with a vertical bar furthest to the right will
take you to the very last page.

| Report Wizard

Q@ - - _

‘ 1 Jof 1 L oS 100% « 1 | Find
R N APPRAISED VALUES

REM PROL GOCN - | RO DUVH MAME | T APPRAS =

e 1N MAN ST 420F"

The scaling of the report preview can be adjusted by left-clicking on the zoom box and choosing
a different level. The zoom level will always default to 100%.
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s A P —e——— ST —————_
1 of 12 3 & e U - 100% = UNIT Fing  Next
APPRAISE (%3 W ;g
Whoie Page |

|

|

' 500%

'. 200%
10020301 1 4 MAIN ST150% ' 420580

| —

|

i ML HERY PRUL BOCH

LEARIE . RO OFIL APPELLS

100203010 10 N MAIN S Ig?}‘ 252960
F-]

100203014 11 1 MAIN svi 50% 252960
-

400203012 IPRRRRTIPS ot 26200 >

You may search the report for a specific value by entering the value to search in the search box
and clicking Find. Additional items with the same value will be found by clicking Next.

Report Wizard
- r =
1 jof 1 ¥ ¥ God AW 100% « UNIT find  Nexi

APPRAISED wu.u:zs(\l N
|

REM ACCT HUN - REM CRUL 10w - REM O'AN N/

10020301 1H MAIN ST W 420580

100203010 10 H MAIN ST W 252960

100203011 11 M MA ST 252960

| 100203¢12 12 1 MAIN 252960

| 100203013 13 N MAR ST ST w il IMICHAEL MILLER 252960

| 1002030 14 14 N MAIN ST ST W UNIT 252960
= - -

You can click on the printer icon to print the report.

GE AW 100% . Find ' Next
RAISED VALUES

REM OW% HARM « | PRC 311 APPRAIS

Ay

RCCT HidsA - REM PR

1002030 TN N ST W

Individual columns on the report may be sorted by clicking the arrows to the right of the column
header.
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Report Wizard

g -
W41 of12 M » = @& G- 100% . [ Fina
APPRAISED VALUES r
MER ACCT MM - L = HER O NAME .
10020301 1 N MAIN STW.
100203010 10 N MAIN ST W
100203011 1M NMAIN STW
100203012 12 N MAIN ST W
100203015 15 HMAIN ST W
100203016 1% N MAJN ST W
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You are here: Report Wizard > Saving and Opening Reports

OVISION

Saving and Opening Reports

The purpose of this document is to assist the user in saving a custom report to be open and run at a later
date. The report will always pull the most current results for the selected fields when run.

1. Once you have chosen your Tables and Fields to be included and entered a Title for
your report, click on the Next button to preview your report. See the Selecting Fields
document for more information.

2. View your report preview, and then click on the Next button.
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3. Finally, name your report and click Save in the bottom-right hand corner of the

screen.

4. The next time Report Wizard is launched, the newly-created report template will be
available in the Custom Report list.
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Custom Report

| Parcels On Override - Edit Delete
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Import PIDs

|
|
8
1]
P e Y

Export Import
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5. To Open a Custom Report Template, click on the desired report in the Custom Report
list, and then click on the Edit button.

Custom Report
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ks
. ; 4 st - . Ve
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6. The specifications from the previously saved report will be selected.
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You are here: Report Wizard > Saving Report as a CSV file

OVISION

GOVERNMENT SOLUTIONS

Saving Report as a CSV file

After creating and previewing a report, you have the option to export the data into a .csv (comma separated
values) format. This allows the user to open the report in Microsoft Excel to further manipulate the data.

To export a report to .csv format, follow these steps.

1. From the Report Preview screen, click the biue Export % " icon.

Ropernt Winars
Gve /’
© 1 of 1 FF N S T ‘ Fd
N

EXEMPTIONS f

‘
1o ' L | TN AR T WY AT Ak (ORE ) ;

i 1 AR ST SETNNO ) R4 0 '

" Y ey ST W AN TOAARY A Ol OO (

L Y Mg 5T AT e DR 17 -

Moo 1 128 M 5T B A T ATV e D00, 000

VR G T TR o R PR I e T L T e— e g

2. Adropdown-list will appear. Choose the CSV (comma delimited) option.

Wl 100% - f
XML file with report dats
CSV (comma delimited)
PDF
MHTML (web archive)
Excel
TIFF file
Warg

3. At this point, you will be prompted to Save the .csv file to a particular location (in this example,
it will be saved to the Desktop).
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Save as type: €SV {comma delkimitad) (*.csv)

* Hide Folders

v & Search Desog

Kathreen Gaudette

Libranes

Harbaor Computer Services Tech
Notes
Irifeeimeed Shuortit

5. Navigate to where the file was saved. The icon indicates it can be opened with MS Excel.

6. Double-click the icon to open the file and work with the data.
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You are here: Report Wizard > Saving Report as a PDF file

OVISION

GOVERNMENT SOLUTIONS

Saving Report as a PDF file

After creating and previewing a report, you have the option to export the data into a .pdf document. This allows
the user to open and save the report in a portable document format.

To export a report to .pdf format, follow these steps.

1. From the report preview screen, click the blue Export icon. "

Report Wizard

it of 1 K o« w @ &AM 100% - Find Next
' Report

: 1 10 MAIN STW MICHAEL MILLER 1 Msin St ©
2 2 N MAIN ST ST W UNIT MICHAEL MILLER 2 Main St
1 3 5 MAIN ST W MICHAEL MILLER 3 Main 51 -

2. Adropdown-list will appear. Choose the PDF option.

| 100% | Fis
XML file with report data .{
CSV (comma delimited) !
PDELS il - |

ll MHTMLY ® aghive) ‘
Excel ;
TIFF file
Word

b et ——— )’r ”,'

3. Depending upon the size of the file, a message may appear while the file is being exported.
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Please wait_,

Cancel

4. Once the export has completed, a Save As window will appear. Navigate to the folder where the
file is to be saved.

() © 7 3 o TP Documents ¢ Raport POSS v & PRSI PRI 2
Cegavge = Nozww todiee H o«
S her Lhatn micchbant
Ay T P
iwm N Aty WAV ponr ety
4§ Doomeats
b &40 65 Do
i Custow Ot Te
i Wy Receiwed doet
b Notdes
4 Opomaer #ro
& Chirioedk Faee
b, Bapan e
4 Seduwe Vsl s v 4 05 P AR - 5
Foe garmg  Aegarin? -
Seve as fype. #DF (* o0} -
* Higa Falders Sevn Concm

5. Name the file and click Save.

(&) ot E s PR AL ¢ Dotumennss o Repor PO v G ‘ oo 7o »

Deganre = Few ruldet Lo 1]

»
M it PC
& Dedaop 1 Pt ik i i e
$ Doguments

-

o

e

o ow W e wm

645955 Docs
Cuseaen Cifige Te.
iy Renwivect Fitey
Morsteg vy

Qutamiker Pro
Dutock Fdes
Repart PDFs

Secure Virtuad A ¥

e nama
Gt 55 e PDF (" gl

)

= Hioe FDigers

Cances

6. Navigate to where the file was saved then open the file by double-clicking or right-click then
selecting open.
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7. The report results will be displayed in the default PDF viewer program.
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You are here: Report Wizard > Save, Import, or Export an RDL File

OVISION

Save, Import, or Export an RDL File

This document is intended to assist the user with saving, importing, and or exporting an RDL (template) file
created once an ad-hoc report is created in Vision’s Report Wizard.

Saving an RDL File
Begin by clicking Reports in the navigation tree on the left-hand side of the screen.

b Parcel
Cranrver Maintenance

at |
R
B T nce I

Co Aopnnw

From the Select Tables and Columns section, identify the tables and related columns necessary to create the
custom report.

1. From the main Report Wizard page, determine the TABLES required from the list provided.

© B R s eTEr cuw > g ed
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2. Click on the plus sign = icon that appears next to the table you would like to include in
your report to view fields available within that table.

Preview Report Columns and Data:

Table Name
NOTES
NOTICEHIST
OBXF
OTHERASS
OVRAD}
PARCEL
REAL_OWNERSHIP
REALMAST
SALEHIST
WISITHST

P4 ¥ B B B @ @ @ @
o

23]

3. Then, click on the boxes to select the individual fields to be displayed on your report.

Preview Repart Columns and Data:

. Table Name
a2 REALMAST
Include | Column Name Sample
"> @a&m_accr_num 13-3506-37

REM_ALT_PRCL_ID
REM_ASSOC_PARCEL_ID
REM_ASSOC_PCT
REM_BLDG_NAME
REM_CROSS_STREET_1
REM_CROSS_STREET 2
REM_FIELD_REVIEW a

4. An option to select field alignment is also available by clicking the Alignment dropdown
and selecting Left, Center or Right.
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Preview Report Columna snd Dats

Table Mame
! Incluxde | Cokemn Name Sample | Farmula Fiter Aigrenent Format L
REM_NSBLU_UNIT |
REM_MBEY_UNIT_CUIT
REM MNC 3415
e/ REMLCWN NANG MURPHY PASHA M - -
BEM_PARCEL STATUS &
¥ PEMPID
BEM_PIN
REM_PRCL 1D i
REM_PRCL LOCN 75 SMITH AvE
5. For any numeric fields, the user may choose a number format by clicking the Format
dropdown. In the example below, we selected a currency format for the Total Appraised
Value field.
P!m-kgou{nﬁ_wu -dmx B R _ y
Takin Naeng
Inciude Calsmn Mame Sampie Forrads Fringe '&m-ll . Fesmat
PRC_TTI,_LPPURTN [ a
PO _TTL APPRALS 229000 . . .
‘e mat oo PR TR ASSINS, Ao ores SIS 7oy A, i o rea Ay Sy "|5':':0 . 'I
PR _TTIL_ASSESS AND THN; "o
PR _TTL_COMP_ADCRTH  § . 00
PRC TTL COAT 15000 . . :‘::gm
8 PRGTTLNCOMD g : 2 m,‘, ;'1 )
PRC TTL AMD AREA ACRES  GAYIOOOGE . Sl bt 1
| MR e Ay
H PRC_TTL BECHRSTION ¢ . | ity diramas
i 0500 =
Provigw Rapost Quigest Gromplyloes = (0008
NEM_PD = REM ACCT NUM  GEM_PRCLLOCN  PRC_TTL ASSESS gm
[ 02-170-04 #1 4M0TH AV .45, 70 —1 [
i 101600 JLOMTHAVE  $140800 000%
Jris L
! 13-0819-00 49 ST AVE Yida 30 QOO0
] W60 3 LANNING LANT $173 70
5 2-0h1i-80 &7 SMETH avE i .80
s BO0BTIA o B SATIHAVE o LR s
3 OB- L 896-12 G 0T AWE 221 800
2 13011400 1T ShYIH AVE §.208, )
1 19-1336-25 6 FANKNING LANE §183400
1 11350637 7% ShATTH AVE $27%,000

6. Asyou select fields, a preview of your report will display on the bottom half of the screen
under Preview Report Output.

e Rapant Gutgast Lo L% ) S ——— | o
WM D RN ACTT M Mt AT | OO, Mol Ooekt it PRCL LOCN, EMIGET Rjed ONFTY Jubha
100908 Y ha s W= a8 paEI s DA W
I 2 T A NG FIAMTTS DATROC £T L
I % Wt At bt A e
i [AY L L] SAGHNL ALVOCAILE baim v T
i i AR A Ol Dl
] k1 FaMAIP S AN WTAMLT BEnliCiy o
L L4 W™ A (o bR TR RTET
' a ] WESON DO 3
v E) WM AN BOoALEN Al |
2 L ARSI AN R L LR A |

o ey
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7. Once you have all of your fields selected, you may change the order of the columns by
single left-clicking on the column header and dragging the column to the desired area.

I. Step 1: Single left-click on the column to be moved.

Preview Report Cutput GowpBylevew | .~ Titte
REM_FID = REMACCT.NUM  REM PRCLLOCN NUM CHAR | REM PACL LOCN STREET | RENLOWN NAME .
g 02-176004 s SMITH AvE BOADEN ASHLEY £ \!)
[ 3-1016-00 8 SMITH AVE WILSON DORIS A
? 15-0449-00 ] SMITIH AVE ORTOLEVA WILLLAM B €T UX
& 19-2016-00 H FANNING LANE STANLEY PENELOPE
5 16-0613-40 8t SMITH AVE JOVCE DENKNEGS £
4 10-0077-52 33 SMITH AVE IAGUES REVOCARLE FAMALY TRUST
a 08-1894-12 byl SMITH AVE MURST JENNIFER
2 33-01la-00 ” SMITH AVE MALKAY FRANCIS PATRICK €T UX
10 19-1329-2% 3 FANNING LANE SIMBRON JERALD A £T UX
1 13-3506-37 75 SMITH AVE MURPHY PASHA M

Il. Step 2: Drag the column to the desired position

MWWI_ Ot i ] T =X Tite: ¢
REM PID = REM_ACCT NUM PRCLUOCN_NUM_CHAR  REM_PRCL LOCN STREET  REM_OWN_NAME
% 02-1760-04 ! SITTH AVE BORDEN ASHLEY £

g D080 n CSMITHAVE - WRSONDORISA |

15-0449.00 ] SMITH AVE ORTOLEVA WILLIAM E. ET UX

3 19-2616-00 1 FANNING LANE STANLEY PENELDPE )
5 10-0611-40 & SMITH AVE ICYCE DEMN E
& 10-0077.52 2 SMITH AVE TAQUES REVOUABLE FANILY TRUST
3 08-1896-12 ” SMITH AVE HURST JENNIFER
2 13-0114-00 " SMITH AVE MACKAY FRAMNCIS SATRICK ET UX
10 19-1329-25 [ FANNING LANE SIMBRON JERALD A £T UX
1 13-3506-37 I SMITH AvE SAURPHY PASHA M

IIl. Step 3: Release the mouse button. The column will now appear in a different area
of the screen.
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Preview Repott Qutput Group By Levels | . Title: -':
REM_PID » | REM_ACCT.NUM | REM_OWN_NAME T REM_PRCL_LOCN_ NUM CHAR | REM_PRCL LOCN STREET ¢
9 62-1760-04 BORDEN ASHLEY £ 923 SMITH AVE F)
’ 23-1016-00 WILSON DORIS A 9 SITH AVE {
? 15-449-00 ORTOLEVA WRLLIAM E, EY UX ] SMITH AvE |
6 19-2616-00 STANLEY PENELOPE 1 5 FANNING LANE
) 10-0511-40 JOVCE DENNIS E 8? SMITH AVE ¢
P 4 10007732 JAQUESREVOCAMEFAMRYTRUST -  SMITH AVE :
3 08-1894-12 HURST ENNIFER b SMITH AVE '
z 13-0114-00  MACKAY FRANCIS PATRICK ET UX 77 SMITH AVE '
10 19.4329.25 SIMBRON FERALD A ET UX 5 FANNING LANE
3 13-3506-37 MURPHY PASHA M s ) SMITH AVE
8. Once all of your fields are added and in the desired order on your report, add a Title to
your report and click Next to view your completed report.
Prrars Mt Cuilpat Oty B Loarn —— . Tew  APPALID AlUn ' S _"I
AEAVLUAD . WMACEY ik e LN PEC T AL
» oz L2904 ¥ T [=Pi% )
X pi AT L] AT RA0m0¢
B Pt L i) 0 M BT (=t g
€ 1B-26.% (00 S ERANNG LARE LTS 0
s 1B-0835-40 & g vt M
L C AT ST AT
1] L R N H U B [S7p 8
7 HERTY 77 SlTH dnk (2 10
b2 wilsaA FHAAAGNG LAN fitian
] PUS » - 2 T3 SMETH AvE i Lia o ]

9. Your Report will appear on the screen.
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- = > P

Report Wizard
L&)
4y o2z r M mmr [l = reainee e 4 & @
ASSESSED VALUES
BEM B S st ACTT B YR FROCE B CNCR R

2 00000401 117 SEA AVENUE §22
3 00000501 113 SEA AVENUE $311,400
q 000BIG01 109 SEA AVENUE $0
L) 00000701 105 SEA AVENUE $0
[ 00000801 99 SEA AVENUE $2
7 00000901 83 SEA AVENUE %0
] 00003001 89 SEA AVENUE $3M4,300
9 D0O05 101 143 SEA AVENUE $2€1,.300

10 00003201 137 SEA AVENUE $1

11 00001301 131 SEA AVENUE 312,900

12 DOCDI401 125 SEA AVENUE $322,100

13 00008501 172 SEA AVEMUE $261 600

iT] 001801 71 MEARS AVENUE $194,200

15 00003 701 79 MEARS AVEMUE $176,000

16 00001801 85 MEARS AVENLE $178,000

17 00001901 118 SEA AVENUE $248,800

18 00002001 132 SEA AVENUE $262,300

10 07002101 108 SEA 8 VE . 257 000 ¢

10. In the lower right-hand section of the page, click NEXT again.

126500
126900
11. Place a check in the box titled Save Local Report
Raport Wizwd
o
fepeet Noime

KESEREED) VAl LES

o Save Lot Rapert
* Save MOw fox GS.

Show S8 |

12. Click Save in the lower right hand corner.
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| New | | Back )

13. Navigate to where the RDL (template) should be saved for future access, make sure the file
has a recognizable title, and click Save.
)

- B .De\-ﬂoﬁ 4 C_m—{ Awprem Desvteg
Orpanze » New folser

& o favarites
B Cesiaop

&
rp
* Yiws BC
i Deownloacls

& Fecent piaces

i
o
Lbtanes -

=

t Network M Conmod Pamel

+ o DreDtron e
o

i Tha IPC

v G

r
Vision WEP Key
% Recyce Bin W1 Dociieent
- {1
b Custeames Sappcd 7 Dooumentation - Shortca? Gaesgle Chramse
k Desicop ',L LN E
I Dorsmients 1S oyt 503 K8
s bindm s e A R = T VO . P _
Fila neme: | ASSERSED VALUES <‘] 2%
Save artype

& Hife Folders

—~

—

]
PO} |

Sew Cancel

- v
14. Navigate to where the file was saved. This RDL may now be shared with other users who
may need that report.

Importing an RDL File

To access an RDL for use, it must be imported to Vision.

1. Go to the main Report Wizard screen and click the Import button in the upper right-hand
section of the screen.
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2. A navigation box will open. It will display the type of file being sought in the lower right-
hand section of the field (rdl files *.rdl).

T b » Omalvive » Documents v 3 Seserh Documents R

Oigamza « Now foider Lo R
Name ) Date moddea Type Size Analatniizy

N dtems Match your searti
< 3 ’
Flerame ) m— T v
Dpen Cancel
——yr - - = .y WOPER TR W " WS VeSS - . v v e, |

3. Navigate to where the RDL file is located and click Open.

352




« + 1 [l Oesklop » v G ek Desking p

New faider - 3 @

‘ OneDirive h Kathieen Gaudette
*' Tivs ¢ Librasics
-
- 7 Daeumentatan - Shomcut
Network J ‘ [ ut
LD ytes

ASSESSED WALUES ndi Harboe Cormgister Services Tech
A5 Fa Noles
252 K8 [ ] Ittt Shnses
WPORT
RIN Fidq
252 KB 1
Fi me: IMPORT roif v oof files oK} v

YD o || oo

s ""_-"—__r-.'-—'-‘"—— T Y T S

4. The imported file should now be available for use.

¥ v

§ w=

5. Go to the Custom Report box in the upper right-hand section of the Report Wizard and
scroll through the list provided to find the newly imported file. Click on Edit to open the

report.
Custom Report
Exemptions Z@:} l & ] | ]|
EXEMPTIONS ™ _Eat | | Delete
IMPORT | ‘:m ]

»

6. The file will open and display the Selected Report Columns and Data as well as a sample of

the data the report will produce.
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Exporting an RDL File

Exporting an RDL file is the same as saving a file, however, the steps are a little different.

1. Follow steps 1 through 9 to create a report in Report Wizard.

2. Once the report is displaying as expected, go to the upper right-hand section of the Report
Wizard screen and click on EXPORT.

Custom Report

Exemptions = Ecﬁt ] | [_)Qlete |
EXEMPTIONS * I i
IMPORT | Import PIDs

Missing Images Repor

)?-_ . > Export ] import
~ *»« VRS %

3. Navigate to where the RDL {template) should be saved for future access, make sure the file
has a recognizable title, and click Save.
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4. Navigate to where the file was saved. This RDL may now be shared with other users who

may need that report.

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Report Wizard > Using the Mail Merge Wizard

OVISION

Using the Mail Merge Wizard

The purpose of this document is to assist the user in generating a merge document in Microsoft Word and Mail
Merge Report in the Vision 8 application.

This document is written assuming a basic knowledge of Vision Report Wizard and Microsoft Word; it is not
intended to teach the basics of either.

To work with the Mail Merge option in Vision, a user must have a valid MS Word template available as well as a
report that identifies the fields to be merged into the resulting document. Any fields that appear in the report that
are not in the letter will be ignored.

Section I: Create Word Document Template

1. Open the Word document that you want to merge with Vision. In this example, the document is a letter
that needs to be mailed to taxpayers.

CETY Of ANYTOWN, MA
2014 NOTICE OF CHANGED ASSESSMENT
THES 1S NOT A TRN BEL
wroer tiyte Ui (e ab oo, Yracs Men v meaperty srsesseeern dne the e e s o Sedr
Frogeity Canes e S T o GUTERE T el nfirnation
! Farcel &
l Adiress:
| Lagl Descriptson: «

Uit v vl b0t B 1wt o SR T A Cowrd et brdesmitan

Cipan Book = Sig. 11 - Aug 15, 3034= SAM - dpen Anvessor - Bold hines
o ok cavgmes ¢ oA oS 5

2. Place your cursor where you want to insert the first merge field. In this instance, we are adding the
Property Owner information. From the Insert ribbon on the Word toolbar, click the Quick Parts drop
arrow, and highlight Field.
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CITY OF ANYTOWN, MA
2014 NOTICE OF CHAMGED ASSUSSMENT
THIS 1S NOT A TAX RILL
Lndpe cTpba & 15@7 a0 7 A% ASANE STIEE | p0ad GEAPSTEy 4 1e et ar Al Terp et paa i i lated ol
Progenty Ownet &8 7 Pavcel bformation

ek Parosd ¥

-t Addren:
ol Lagal Description: «
'.“.h..1 il

3. Select Merge Field and enter the Field Name EXACTLY as is it listed in Vision, from the Report
Wizard select Tables and Columns list, then click OK.

o Fresenym durneg upsdates

|

T UV W W T ES W T

MAD _MAIL_ZiP 000000000
OWN_NAME MICHAEL MILLER
OWN_NAME? MARY MILLER
ROW_MNC 59399

ROW_PID 1

i

Preview Repont = ~* Geour > Levaly |

éfgi The newly chosen field will be added to the Word document.
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2014 NOTICE OF CHANGED ASSESSMENT

THIS IS NOT A TAX BiLL

Uruder stata law {Sec ab cde, Mass Stets |, your ofcoeily ssininmar For the current yeoe it Bsted beiow,
Property Owner Parcel information
«OWN_NAMEL® Paresd ¥
Address:
Lagal Deseription; «

Continue this process until all fields have been added to your Word document.

CTY OF ANYTOWN, MA
2014 NOTICE OF CHANGED ASSESSMENT
THIS IS NOT A TAX BRL

Lnider stare law |Seg ab (e Mass Stars 1, VOUr prOpety arsesimest 107 the clriemt yedr i ltad below

T 5

AMEL® ‘ Paccel @ «REM_ACCT_NUM»

COWN_
S«OWN_NAME2» Legal Description:
«MAD_MAIL_ADDR® aPRC_DESCRIPTION=

€MAD_MAIL_ADDR2S
EMAD_MAIL_CITY», sMAD_MAIL_STATE® ®MAD_MAIL_ZIP»

General Information Contact Information

Open Book - Aug. 11 - Aug 15, 2014 - 9AM - 4pm Assessor = Bob lones

Board of Review — August 27, 2034 ~ SAM (617) 555-1212, tassessor@anytown.net

Meeting Location — Common Coumell Chambers Municipal Clerk = Fred Smith

(617) 555-1313, tclerk@anytown.net
Assessment Change
General Property PRO/MFL

YEAR | TOTAL VALUE

0ie SHPRC_TTL_ASSESS»

2013 S wAND_TT1_ASSESS»

Total Assessment Change [ S <PRC_TTL_ASSESS - AHD_TTL_ASSESs~

Reason for Change(s)

| I 1
Neca oy Sancultursl Ly - wm?”hm-- WOV TSR me T e et e e gt law Taes A 0t

4. When all the necessary fields are entered, go to File and choose Save As.

iy v & : " - pa—y ‘“‘ _
-[. insert  Page layolt  Refersnces Malings  Review  View  Developer Detign
bl sev :
T <®&format;on about Document5
& Open o Permissions
s &s ) _ﬁ" Anye == can open, Lopy, and change ~= oart of Mis docum =

5. Choose the location where you want to save this file and click Save. Change the Save as type to Word
Document Template {.dot, or .dotx depending on the version of MS Word).
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Section II: Create Report in Report Wizard

v &

G/16/2014

Date moddif e
150 Prt

A2G14 150 P

174072004 102 P

1IA2004 203 PM

1. Navigate to the left-hand menu tree, and click on Reports

(L Parcet

Owner Maintenanoe

o

Ehﬂew

Comps #& Apportionment

Cost Modeling

[ Track Changes

WY

- 'y‘ﬂ:ﬁﬁvu-;_g|w

ey Bepaoty -

W2 aeed P
R
Type
e ol

File Toley
Micrssofr Woed Te

Microsoft Woed To

2. Create a new report and add the necessary tables needed to extract data for the letter.
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3. When all of the proper fields are added to the report, click Next under the preview pane, to
verify that the report will run and produce the desired results.
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4. Click the Back button to return to the Report Wizard main page.
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MA 00000-0000 MICHAEL

MA Y00-0000 MICHAEL ,,

2>
5 S 35 J

| New Wl [cBack] iNeth Save

5. Go to the Mail Merge section of the Select Tables and Columns area at the top of the Report
Wizard main page.

Repart Wigard
Seloct Tables ano (plumess Q
sefect a samplo mow of data Colrn View Options Rapont pe Msit Merge
1 & Show Parcel Data T bl Mg £ Sove to Associeted Dox
'. i '_ :____d _W Show Al Tabde Data ‘D Tabrula Temphate - Browse
Sha Friemdly Names ’:} oin
Sne Bicwse

| Show Actve Paccel

& Shom Preview Report Columns anc Date ' Show Selectad Renont Cokumns anid Nata

You will find a few options:

e Mail Merge check box - Indicates a mail merge is being created with the Report Wizard.

¢ Save to Associated Doc - Indicates an individual copy of the merged document will be
attached to each parcel affected as an Associated Document.

e Template - Shows the path to the template being used for the merge resides.

¢ Save- Indicates where the final, merged document file will be saved, for review, printing,
etc

6. Place a check in the Mail Merge box, and click Browse to go to where the Mail Merge Template
has been saved.

1

il Merge 2
Mail Merge Save to Associ C
Template: _émws«e |
Sowm | Browse

7. Navigate to where the Mail Merge Template resides. Highlight the Word Template (identified as
a .dot or .dotx file), and click Open.
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You will be returned to the main Report Wizard page, where the path to the merge
template has been entered

Mail Merge

V] Mail Merge (] Save to Associated Doc
Template: i\Customer Support Docs'_7 Documi| §

Save: | Browse

8. At the Save line, click Browse to navigate to where you are going to save the merged documents.

Mail Merge
[¥] Mail Merge ‘ | ] Save to Associated Doc

Template: ICustomer Support Docs\_7 Documi|_Browse |

Sove [rowse |

9. Go to where the merged documents will be saved, and add a File Name (NOTE: the documents

will automatically be saved as either a .doc or .docx file because the template used is an MS
Word Template). Click Save.
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& Pictures 17 Report Wizard - Saving Repart as PDF H/20/2013 30000 Microsoft Word D 1079 K
i Smagit L7 Report Wizard - Saving-importing and €. 10312004 157 PM Microsalt Word D ) 158K
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You will be taken back to the main Report Wizard screen.

10. Click next in the lower right-hand corner of the page to start the Mail Merge process.

Froeasy Report Qutpait Gty By tomis g Growpldy . Tile. e faoces
[-x-if‘ LROTHIR AT ACTT MU WAL WAL ATOST A Mak ADKEG MAD SRR (177 Mal MaL STATC N ML 7% RN | (A NAMED | AMD TIARIESS P TTLASHRS
o WIS Ve —— e A e s MO0 ACHALL WALLER WAATY MLUER 0 ot
L (L W & Ay A RSN G Wde LR LR N
I I g O [LEY W e Rl MAdLE oW (B
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Lk o LT b, n ara 00 gL LS
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\ ¥ 1 M e A WAl 8 Q

The Mail Merge will now begin. As the process is running, the screen may flash several
times. The Next button will remain inactive, and highlighted in blue.
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Once the merge has completed, the Next button will become available, as indicated by the
button no longer being highlighted in blue.

11. Click Next to proceed to the end page of the Report Wizard.

[y = [Nors] <o

12. The wizard will show the end page.

13. Navigate to where the merged document was saved in Step 14. There will now be a file folder, a
Word document, and an HTML file, all carrying the name given to the Save file in Step 14.

Hame G vhw - @
) < ¢ b+ Cwbomer Suppon Docs » 7 Documentation » Verian T+ Mait Merge Docs ¥7 » v ) Searen Mas Marge Doas ¥/ p
-

& Favorites Name (RTINS IE

W Cesktop k Morged Docaments_filed <® { 1AM 15 A il fokoe

B Downloads W Mergeid Documents < ®_‘ | TANFIA AL Mroosdl Wiike PErER

U Recent places | & Macgen Dacuments VIAR0IA WA KM [egument 871 <&

i < 3yt w

A OngDvive

W Thes PC
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The Merged Documents_files folder contains information about the newly created
document.

Hiene Shass View e,

{"} « b« 7 Dacgmentation = Yersion 1 v Maii Merge Docs V7 v Merged Dacuments files v & SemoMesgen Gooomesse . P

5 tavontes A Hame Py ol by fype yare

B Desciop 2 colonchememapping 1 IO A KWL [outren

» Downkosds L el VT XN TG A iy [

ip Recent places i heeader VTN TG A HITME Dy i I wii

R inemedita U SRAON HRE A M ract Cofice 4
o OneDrvee
& Thes P

The Merged Documents Word document will contain a copy of each letter generated in
the merge process. These documents will print as individual pages for mailing.

e K > & st Lol g P - POC R I v e

2014 NOTICE OF CHANGED ASSESSMENT

!
1 CITY OF ANYTOWN, MA
|
| THIS ISNOT A TAX BiLL

voperty Owner Pascel Information

l MICHAEL MILLER Parcel 8: 100203032 [
MARY MILLER Legal Description:

| 32 Main 5t V7 Documentation

! Actown, MA 00000 0000

| General information (oract Informaton
|
I Open Book - Augg. 13 - Aug 15, 2014 - SAM - dpm Aaswon ~ Bob lones
Board of Review - Awgust 727, 1014 - 9AM (617) 3931212, tassassor @ anytown, net
Mosting Locsition - € Council Chambers Municipsl Clerk - Frad Smith
FANEWaagy pd A w.r *
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CITY OF ANYTOWN, MA
2014 NOTICE OF CHANGED ASSESSMENT

THIS S NOT A TAX BILL

Under irane [ (360 30 102 Wass 1ML, vour praperty Assessment for thw curment year Is jisted beiow
Property Owmer Parcel Wformation
MICHAEL MILLER Pureed 100203088 { g
MARY MILLER Legal Description:
39 Main & V7 Documentation
Anytown, MA 00000-0000
Greeeral iformation Contact dorm ation
4
Ougs Bock - Sug, 11 - Mg 13, 2014 - DAM - Jpm Assessor — Bob Jones Y
- ~ ] - any gy 4 "t
CITY OF ANYTOWN, MA
2014 NOTICE OF CHANGED ASSESSMENT
THIS 18 NOT A TAX Batl
Umlpr (tte faw {50 4 M. Ma: St 1 v progmTly Beietidvevit tof Dhe Gartent yedr i HITRG Beiow
Properry Owees Parcel information
MICHALL MILLEN Parcel #: 100203034 < !
MARY MELLER Legal Description:
34 Main St V7 Documentation
Anytown, MA 00000 G000
Oerus ol ok v ation. Comtact i cnimatn
Open Book — Aug. 11 - Aug 15, 2014 - 9AM - dpm Assesior — Bob lones
Board of Review - August 27, 7034 - 9AM (617) 555-1212, Lassemon @ anytown. net
Meaeting Location - Councll Chambess Municipal Clerk = Fred Smith

TR LR

The HTML file contains a web-based representation of all of the documents created and
can be used to review the pages prior to printing and mailing to Taxpayers.
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Merged documents can also be added to the Associated Documents section of a parcel by
indicating that the doc should be Saved to Associated Doc in Step 11.

Mail Merge

(V] Mail Merge | [v] Save to Associated Doc
Template: [\Customer Support Docs\ 7 ch_t__u_mr
Save: I\Customer Support Docs\_7 Docum-z| Browse |

The program will prompt you asking how you would like to store this file. If you choose
database this file will be added to the Vision Database. If you choose File Share the
document will be saved to the Vision Documents Shared Network folder .

® Database 7 File Shane

The process will create individual files in this case, as it will associate each doc to the
specific parcel selected to receive the mailing.
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To verify that the document was attached, navigate to a selected parcel, click on the
Associated Documents link from the Associated Documents sub menu, located in the tree
on the left side of the screen.

TR A e

Account Maintenance

Associated Documents
Associated Documents (1)

Summary Review Screen *
Dashboard

ot b -

The newly added file will appear in the grid.

Descniption Pnmary Stat Date File Name
» ’ ’ 110772014 mergedd_25.00¢

[ e Primary

You can enter a description for the document if desired. To add a description, click on the
document line you with to modify and then type your description in the field below.

Description =  Primary Stat Date File Name
»  Sample Mail Merge/Assoicated Document process 1072004 mergeds_25.doc
] V] ] ot QQ/
Sample Mail Merge/Assoicated Dacument process m 1 bs Primary
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You are here: Cost Modeling Basics

OVISION

GOVERNMENT SOLUTIONS

Cost Modeling Basics

This document outlines the foundational elements of Vision Cost Models.

Disclaimer

A Please note that any alterations to the Cost Model will impact parcel valuation. There is no undo button to roll back changes once applied.
Please verify that a valid database backup is in place prior to altering cost models. Additionally, you may wish to print a cost model report for
reference before making changes. To do so, navigate to CAMA > Reports > Rate Files > Building and Land Rates, select Cost Model Report, then
click View Report.

Before We Begin

This documentation follows a residential building with style code SMP: Sample Style having a base rate of 100 with no size adjustment. Below is
an excerpt from the sample parcel Cost.dat. The Cost.dat is accessed by selecting Utilities > Recalc Parcels > Recalc Reports > Cost Report, or by
selecting the Cost Report icon & from the top of the screen.
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The RCN Equation

The Cost Models provide multiple elements included in the RCN equation. The various equation elements are outlined below. The elements
provided by cost models are in bold.

RCN = ({Adjusted Base Rate * Effective Area + Factored Unit Value Additions + Factored Subareas)
* Multipliers) + Non-Factored Unit Value Additions + Non-Factored Subareas

Adjusted Base Rate: Base Rate + Cost Model Base Rate Additions

Effective Area: Total Building/Section Effective Area as Calculated By the Sketch

Factored Unit Value Additions: Lump Sum Value Additions Factored by any Multipliers

Factored Subareas: Square Foot Price Valued Sketch Areas Factored by any Multipliers

Multipliers: RCN Multiplier

Non-Factored Unit Value Additions: Lump Sum Value Additions Not Factored by any Multipliers

Non-Factored Subareas: Square Foot Price Valued Sketch Areas Not Factored by any Multipliers

Cost Modeling

Access Cost Models by Navigating to CAMA > Cost Modeling > Cost Valuation Codes
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Cost Modeling

Cost Modeling 2
Cost Valuwtron Cocdes

The Cost Valuation Models screen displays data in three individual panes.
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Left Pane: List of Available Cost Model Groups. These are assigned in CAMA > Cost Modeling > Assessing Neighborhood Base Rates: Cost
Model Column

Center Pane: List of Individual Cost Models Included in Cost Model Group Selected in Left Pane.
Right Pane: Coefficients Associated with Cost Model Selected in Center Pane
To create a new model, select - “* |in the top right hand corner of the screen.

To edit an existing model, select the model group from the left pane then the target model from the center pane. Once selected click - **in
the top right hand corner of the screen.

Coefficient edits are performed in the coefficient column of the Right Pane.

Model Development

This section outlines the various components of primary variable and dependent variable development. Values generated from primary variables
apply directly to the building calculation. Dependent variables are linked to primary variables to further transform the primary variable. While
handled differently in value calculations, configurations of primary and dependent variables are similar. Due to this, configurations of like

primary and dependent variables are explained in tandem.

Numeric (Primary and Dependent)

Numeric models are intended for use with numeric construction detail fields to multiply the field value by the model coefficient. This is often
used for elements such as fireplaces, bathrooms, and finished basement area.

Page 1 — Variable Definition
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This screen is used to define the variable. In the Type dropdown, select Numeric for a primary variable, or Dependent Numeric for a dependent
variable.

Page 2 — Field Assignment
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Expand the appropriate table then select the target database field for the model.

Page 3 — Coefficient Value
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Enter the value to be multiplied by the field value.

Page 4 — Apply To

Choave How Yo Apply The Adjusaaeat
U ]+

= 0] U 11 0 i s the Cama o B Biary

This screen is configured for Primary Variables only.

Standard for Numeric Models

Units (Factored): Applies coefficient to field units. Adjustment is applied prior to multipliers in RCN formula.
Flat Units (Non-Factored): Applies coefficient to field units. Adjustment is applied after multipliers in RCN formula.

Other Adjustment Applications may be used but are outside of the scope of basic cost model development.

Page 5 — Additional Operations
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This screen allows for configuration of additional mode! criteria.

User Defined Operations: This field combination allows for adjustment of the field value. Select the desired operation from the drop
down, then enter the desired value in the Value field. Example — The user assumes the base rate includes one bathroom. The model
should only apply value for bathroom count greater than 1. Operation = ‘+ Add’; Value = -1. This will add -1 bathrooms to the total field
value.

Enter Minimum / Maximum Range: Enter the minimum and maximum model values. Example ~ The user only wants the model to apply
positive adjustments for up to 3 full bathrooms. Min Value = ‘0’; Max Value = ‘3",

Else Value: For numeric variables this is not applicable and is set to 0.

Page 6 — Has Dependent Variable
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This screen is configured for Primary Variables only.

in some instances, primary models require additional custom operations. This screen facilitates linking one or more dependent models to
primary models. This linking is covered later in this document.

Page 7 — New Variable Summary
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This screen allows for mode! configuration review. Upon completion click Finish.
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Binary (Primary and Dependent)

Binary models are used to transform alphanumeric data to numeric values. This type is often used for elements such as exterior wall, roof type,
and grade.

Page 1 — Variable Definition
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This screen is used to define the variable. In the Type dropdown, select Binary for a primary variable, or Dependent Binary for a dependent
variable.

Page 2 — Field Assignment
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Expand the appropriate table then select the target database field for the model.

Page 3 — Binary Codes or Breakpoints

ot g i b s Sy W
]
Dot Up Your Binary Cous OF Breel points
By Vbl Codt
tdd Nem Loder et Vo ey
-3 Latpreye
AN
2 tatrgre
o0
N r=sw
n
8
ar
A
0
e [ Pt

This screen facilitates the inclusion of field value codes in the model.
To manually enter individual codes, type the desired code in the box next to ‘Add New Codes’ then click the ‘Add New Codes’ button.
To select all codes currently used in the field selected on page 2, click ‘Database’.

To select all allowable codes from the associated field picklist, click ‘Rate Table’.
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To remove a code, select it from the list box and click ‘Remove’

Page 4 — Apply To
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This screen is configured for Primary Variables only.

Standard for Binary Models

+ Base Rate: Applies coefficient to the Base Rate value in the Adjusted Base Rate Calculation. *Note — if Apply as Percent is checked, this
will apply the adjustment as a percentage of the base rate.

Multiplier: Applies a multiplier in the RCN equation. If multiple multiplier models exist, the results are multiplied together to arrive at the
final RCN equation multiplier.

Units (Factored): Applies binary coefficient as a flat value. Adjustment is applied prior to muitipliers in RCN formula.
Flat Units {Non-Factored): Applies binary coefficient as a flat value. Adjustment is applied after muitipliers in RCN formula.
Eff Age: Applies an adjustment to the effective age calculation. *Note - These adjustments are applied to the RCNLD, not the RCN.

Depreciation: Alters the calculated depreciation after effective age calculation. *Note - These adjustments are applied to the RCNLD, not
the RCN.

Page 5 — Additional Operations
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This screen allows for configuration of additional model criteria.

User Defined Operations: This field combination allows for adjustment of the field value coefficient. Select the desired operation from the
drop down, then enter the desired value in the Value field.

Enter Minimum / Maximum Range: Enter the minimum and maximum model values.

Else Value: Populate the default coefficient value for use in calculation if the field value does not exist in the variable fist.

Page 6 — Has Dependent Variable
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This screen is configured for Primary Variables only.

In some instances, primary models require additional custom operations. This screen facilitates linking one or more dependent models to
primary models. This linking is covered later in this document.

Page 7 — New Variable Summary
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This screen allows for model configuration review. Upon completion click Finish.

Coefficient Assignment

After finalizing the model, individual coefficients must be set on the Cost Valuation Models screen. Select the new model from the center pane,
then assign required coefficients in the right pane. Once complete, click Apply in the lower right hand corner of the screen.
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Breakpoint (Primary and Dependent)

Breakpoint variables integrate the functionality of Numeric and Binary variables. The modeled field value must be a numeric value, but the
behavior is like that of a binary as it transforms a numeric range to a single variable coefficient as indicated through model configuration. This is
often used to apply one adjustment for one value range, while applying alternate adjustments or no adjustment to other value ranges.

Page 1 — Variable Definition

375



This screen is used to define the variable. In the Type dropdown, select Breakpoint for a primary variable, or Dependent Breakpoint for a

dependent variable.
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Page 2 — Field Assignment
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Expand the appropriate table then select the target database field for the model.

Page 3 — Binary Codes or Breakpoints
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Use this screen to manually enter individual breakpoints. To do this, type the required breakpoints in the box next to ‘Add New Codes' then click

the ‘Add New Codes’ button. The model value is determined by selecting the first break point greater than or equal to the field value. For
example, if the breakpoint values are 2 (coefficient of 0), 5 (coefficient of 500), and 10 (coefficient of 1000), and the subject value is 3, the
variable value will be 500 because 5 is the first breakpoint greater than or equal to 3. If the subject value is 12, this value is greater than the
maximum defined breakpoint therefore the variable value denoted in the Else field configured on Page 5.

Page 4 — Apply To
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This screen is configured for Primary Variables only.

Standard for Breakpoint Models
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+ Base Rate: Applies coefficient to the Base Rate value in the Adjusted Base Rate Calculation. *Note — if Apply as Percent is checked, this

will apply the adjustment as a percentage of the base rate.

Multiplier: Applies a multiplier in the RCN equation. If multiple multiplier models exist, the results are multiplied together to arrive at the

final RCN equation multiplier.

Units (Factored): Applies binary coefficient as a flat value. Adjustment is applied prior to multipliers in RCN formula.

Flat Units (Non-Factored): Applies binary coefficient as a flat value. Adjustment is applied after multipliers in RCN formula.

Eff Age: Applies an adjustment to the effective age calculation. *Note - These adjustments are applied to the RCNLD, not the RCN.

Depreciation: Alters the calculated depreciation after effective age calculation. *Note - These adjustments are applied to the RCNLD, not

the RCN.

Page 5 — Additional Operations
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This screen allows for configuration of additional model criteria.
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User Defined Operations: This field combination allows for adjustment of the field value. Select the desired operation from the drop

down, then enter the desired value in the Value field.

Enter Minimum / Maximum Range: Enter the minimum and maximum model values.

Else Value: Populate the default coefficient value for use in calculation if the field value exceeds the maximum configured value on Page

3.

Page 6 — Has Dependent Variable
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This screen is configured for Primary Variables only.

In some instances, primary models require additional custom operations. This screen facilitates linking one or more dependent models to
primary models. This linking is covered in subsequent sections.

Page 7 — New Variable Summary

[ETFTTIPRITEEE S L]
1

L* )

Now Varabis Summary

This screen allows for model configuration review. Upon completion click Finish.

Coefficient Assignment

After finalizing the model, individual coefficients must be set on the Cost Valuation Models screen. Select the new model from the center pane,
then assign required coefficients in the right pane. Once complete, click Apply in the lower right hand corner of the screen.
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Constant (Primary and Dependent)

Constant models allow for direct injection of numeric data into the calculation. The coefficient is the constant value. Constant models are
typically used as dependent variables.

Page 1 — Variable Definition
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This screen is used to define the variable. In the Type dropdown, select Constant for a primary variable, or Dependent Constant for a dependent
variable.

Page 2 — Coefficient Value
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Enter the coefficient value.

Page 3 — New Variable Summary
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This screen allows for model configuration review. Upon completion click Finish.

Dependent Models

Depending on calculation requirements, it may be necessary to link one or more dependent variables to a primary variable. The numeric output
of primary variables is included in the cost calculation. The numeric output of dependent variabies is considered in the primary variable
calculation.

Dependent variables are linked to primary variables in the ‘Has Dependent Variable’ page. Here the user has the option to link one or more
dependent variables to the primary variable. In some instances, the operations should be applied in sequential order where other cases may
require the grouping of dependent variable calculations prior to application to the primary variable. For this flexibility, the software includes a
‘Group Dependent Variable’ option.

The following Primary / Dependent Model group is present for demonstration purposes. For ease of explanation, the Constant/Dependent
Constant variable types are used.

GROUP_DEMO is the primary variable with a Coefficient of 1500
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GROUP_DC1 is a dependent variable with a Coefficient of 750
GROUP_DC2 is a dependent variable with a Coefficient of 0.50
GROUP_DC3 is a dependent variable with a Coefficient of 300

220 GROUP_DEMC Group Dependent Vanable Demo £

20 GROUP XL Group emna Dependent 1 B
20 GRCUP IX2 Groug Demo Dependent 2 oC
X0 GROUP_DCI Group Dems Dependent 3 .

The dependent variables are linked to the primary variable as shown. For the first example, the Group Dependent Variable box is unchecked
indicating sequential calculation.
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The calculation occurs as follows:
{{({GROUP_DEMO + GROUP_DC1) * GROUP_DC2) + GROUP_DC_3)
{({1500 + 750) * 0.50) + 300} = 1425

As seen in the Cost.dat:

Group Dependent Variable Demo = 142500 + RCN

If the model is then updated by checking the ‘Group Dependent Variables’ box, the calculation is then processed as follows:
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GROUP_DEMO + ((GROUP_DC1 * GROUP_DC2) + GROUP_DC_3)

1500 + ((750 * 0.50) + 300) = 2175

As seen in the Cost.dat:

Group Dependent Variable Demo = 2175.0C + RCN

Cost Modeling Tips and Tricks

The following address some common cost modeling guestions.

Minimum/Maximum Values

If the calculated value is greater or less than expected, check the minimum / maximum values for the cost model.

Example: The cost model states that each fireplace should generate $5,000 in value. The subject parcel has 5 fireplaces. The expected value is
$25,000. The Cost.dat shows a value of 15,000. This may be due to restrictions placed on the cost model in the Additional Operations screen.
Note that this model has a Max Value of 3, indicating that if the data in the fireplace field is greater than 3 the model witl use the value 3 in the
calculation. To value all 5 fireplaces, update the Max Value field in the model and click apply.
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Example: The cost model contains an additional operation to subtract one full bathroom from the total value in the full bathroom field. Due to
this, buildings having 0 full bathrooms should have a negative value adjustment. Review of the cost report for a building with 0 full bathrooms
does not show a full bathroom adjustment. This may be due to the Minimum Value set on the Additional Operations page. Because of the
additional operation of ‘Add -1, the field value is now -1 but the Minimum Value is 0. The Cost Model uses the minimum acceptable value of 0
for the calculation. To allow adjustment for zero bathrooms, update the Minimum Value to “-1".

Enabling/Disabling Models

There are instances where a model is only relevant for a specific parcel type. An ‘On/Off’ switch may be developed using a dependent binary
model with the filter field selected in the model. To enable a model for a specific code, set the respective coefficient to 1. To disable a model for
a code, set the respective coefficient to 0. Then assign this dependent binary model to the primary variable with a ‘Multiply’ operator. This
follows the principle that anything muitiplied by 0 is 0, therefore effectively turning the model ‘off’.

Else Values

A user may encounter an issue where a model is generating value for a building when not expected to do so. If this occurs, review the Else Value
on the Additional Operations page. The value in this field is the default coefficient when the binary or breakpoint entry is outside of the bounds
of the model variables.

Model Created / Not Generating Value

This issue may result from multiple issues. When testing models, be sure that the test parcel is in the same model as the newly developed cost
model. Also, verify that the model was saved properly by clicking Apply after creation. If updating coefficients, be sure to click Apply or Save after
update. If there is still an issue, be sure there is not a multiplier dependent variable calculating to 0 which may effectively shut the model ‘off’.

Database Field Assignment

Each model developed is prone to user error. Example: A model was created to value fireplaces at $5000 each. The test building has 1 fireplace,
but the Cost.dat shows $10,000 for the fireplace model. A review of construction details shows that the parcel has 2 chimneys. Review the
Table/Field page in the cost model to validate proper database field linking. It is possible that upon creation of the model, it was accidentally
assigned to the chimney field as opposed to the correct fireplace field. Note that in the Cost.dat, the report shows the model label created by
the user, not the database field name or label.

Sample Cost.dat

Below is a sample Cost.dat with notes to locate the various report elements.
Cost.dat

OUTPUT FROM NEW COST MODELING ENGINE

REPORT GENERATED ON 10-Sep-2018 AT 15:11

Wik ek ngilding #1 Calc Start* ¥+ ##sxrexnsmsx

Cost Calculation for pid, bid = 7257, 7257

Account Number = SAMPLE Parcel > Legal Information > Account Information

Use Code = 200R Table Maintenance > Cost Use Codes > Building Use

Cost Rate Group = SIN Table Maintenance > Cost Use Codes > Group
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Model ID: = PO1 Cost Modeling > Cost Valuation Codes > Code
Section #1 Parcel > Building Information > Construction Details: Section
Section Use: SFD - Suburban — Res Parcel > Classification & Land Information > Code (Line #1 for Building)

Base Rate: 100.00 Look at Parcel > Building Information > Construction Details > Style, then toggle to Table Maintenance > Cost Group Rates >
Base Rate (Link on Cost Group Rate & Style)

Size Adjustment: 1 Based on Table Maintenance > Building Tables > Style Codes > Size Adj and Table Maintenance > Building Tables > Cost Use
Codes > Size Adj. The Code then links to Table Maintenance > Building Tables > Size Adjustment Table > Code

Effective Area: 1200 Parcel > Building Information > Depreciation > Effective Area

Adjusted Base Rate = (100.00 + 0.000000) * 1 (Base Rate + Base Rate Additions) * Base Rate Adjustments]
Adjusted Base Rate: 100.00

RCN = ((100.00 * 1200 + 10500.000 + 5440.000) * 1.20) + 10000.000 + 2560.000

((Adjusted Base Rate * Effective Area + Factored Unit Value Additions + Factored Subareas)
* Multipliers) + Non-Factored Unit Value Additions + Non-Factored Subareas

RCN: 175688

kbR RR R KON I nits Value Additions* X *®¥ ¥k xkkaxikx (Factored Unit Value Additions)
Full Bath(s) @ $5000 Each = 10000.000 + RCN Cost Model

Extra Fixture Breakpoint Value = 500 + RCN Cost Model

ERERIHERKEERRRERNECLOr AdjUSEMENTSHHHH3* + K%k kx skt k5 (Muyltipliers)

Grade G =1.20 x RCN Cost Model

Aok kR RR KA Ok RORRE] ot Value Additions* ¥ *¥ ¥ kkikkxxxkk (Non-Factored Unit Value Additions)
Fireplace(s) = 10000 + RCN Cost Model

Kk AR RR R R K gctored Subareas®* ¥R KRR EXEM (Eactored Subareas)

Subarea Total = 5440.000 Table Maintenance > Building Tables > Subareas: Use Square Foot Price/Use Grade
rERkk kbR kR xRN o0 Factored Subareas***Fr ik xrAk*kX (Non-Factored Subareas)
Subarea Total = 2560.000 Table Maintenance > Building Tables > Subareas: Use Square Foot Price
Actual Year Built: 2008 Parcel > Building information > Depreciation > Year Built

Effective Age = 4 Capture Parcel > Building Information > Depreciation > Year Built & CDU/Condition Table Maintenance > Building Tables >
EYB Depreciation > Link AYB to Year Built & Code to CDU/Condition to determine Effective Age

Percent Good = 96 Parcel > Building Information > Depreciation > Building % Good
RCNLD * Trending = 168660 * 1.000
RCNLD: 168700

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Comp Sales Values

O VISION
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Comparable Sales Values

This document outlines the process to calculate Comparable Sales values in Vision.

Update Recalculation Settings

1. Inthe ADMIN application, select Table Maintenance > Building Tables > Recalculation Settings

2. Set the Run Comps flag to ‘YES’ for each Building Use where a calculated comparable sales value is
required.

3. Once recalculation flags are set, click “** in the lower right corner of the screen.

4. Return to the CAMA application for the remainder of the process.

Run Sale Trending

Comparable Sales valuation requires successful completion of the Sale Trending process. If the market indicates no
trend adjustments are required, the process must be run with adjustment values of 0. This process populates the
time adjusted sale price field which is required for comparable sales functionality.

Please reference How to Use Sale Trending for process details.

Extract Comps Snapshot from Master

Prior to extracting comparable sales, please verify and archive the latest database backup. The backup file is
required to restore the database should an error occur in the extract process. This process does not have an ‘Undo’
function.
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1. Select Utilities > Comp Snapshot Utilities > Extract Comps Snapshot from Master

2. Review the Vision Warning, then click OK to proceed.
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Thes wibl enzure that your backup daes not get ovenmriten in Case pour
dyty needs to be restaved.

oK

3. Indicate the required extract criteria.

—

* Cargs Jvepinat Uhtes fobie
Latract from Master D8 into Comgs DI

Oty ——

i valuation Tabla Informion l

7| inchate lncomes Tabin t

o] Parcel Dt |
2 inchude bwome Diats

Soles Dog ——————————————————————————————
Cinky extract partetz yehected below that do not curnmtly emisi ln the tanpet datsbhase
Replice ol pormek selected befom whether or nod theey curently st in the torpet databme

@ Delete ol existing pescets mwl extract perceh uelncted belo

| Creete Conda Matnn for vow: | 2047 )

¢ Cuntom Sebcvion Criterin
FROM realmast . salebwt const, bidg
[ WERE redimast.resm_ownc « 9048 ail sabehisasih_quatfied = 1 and sslehestalh_sele_date > 1
WIS endt valphing.uh_usie_date < ¢ 'L 2315010 sl conety cm_medl = 1} AND |
rmabmast REM PARCEL STATUS » ‘A aril b6l bAdg miis = 1 AND sealsast seim ese |
aalabint wily mive AND emaderuant sarn pid = salelwslaih pad AND blidg hid mee = comitrom mne |
| AND bisg.bid_pid = constr.cns_pid AND bidg.bkd_ted = corats cns_tid AND resimast rem one = | 1

R Ry £ A

Crwate Cuntem Ql-ﬂ Ch;_tn:!—\- M !

a. Options:

. Valuation Table Information: Copies current rate and configuration tables from the

Master database to the Comp Sales database.

ii. Include Income Tables: Copies current income related rate and configuration tables

from the Master database to the Comp Sales database.

Parcel Data: Copies parcel characteristics from the Master database to the Comp Sales
database.

Include Income Data: Copies income specific parcel characteristics from the Master
database to the Comp Sales database.

b. Sales Data:

Only Extract Parcels Selected Below That Do Not Currently Exist in the Target
Database: Retains parcels present in the Comp Sales database, and adds additional
parcels as indicated by the selection criteria. If a parcel scheduled for extract currently
exists in the Comp Sales database, the routine will bypass that parcel.

384



ii. Replace All Parcels Selected Below Whether or Not They Currently Exist in the Target
Database: Retains parcels present in the Comp Sales database, and adds additional
parcels as indicated by the selection criteria. If a parcel scheduled for extract currently
exists in the Comp Sales database, the routine will extract a current copy of that parcel.
This may result in duplicate parcels in the Comp Sales database

ii. Delete All Existing Parcels and Extract Parcels Selected Below: Deletes all parcels that
exist in the Comp Sales database and adds new parcels as indicated by the selection
criteria

iv. Create Condo Mains for Year: Enter current year
c. Click [Sreste Custam@umey): Comparable sales are extracted based on user defined criteria

i. Range of Parcels Tab: Set appropriate Sale Date Criteria and indicate any additional filter
criteria

ii. Advanced Tab: Uncheck ‘Only Select Current Owner Sale’

iii. Click Ok when extract criteria are complete

* Cuttors Purcel Seaech - Codai
Tange CF Parces Paced Seimctive| Advincnd | Runge Of MBLL
Parcd Selection [Active -
Arcownt Numbea kom Te
SWIS Fream Ts
Lacaton Praen To
Owryers Narwe Fom Te
Deote Parcnl Last MisSfied From Ta
Rasi NORE i -
Comm NBHD -
Coreicy 4880 -
Siyle .
Mades = p
Pewnary Use T apw—. |
Lise Type .
Claws l -

\\ w| [ Misad e -‘
e Cade =
Sate Daba oo | 112004 Te | L2/3L2016

P Inchiace Unguaified Seles?

2 Qualibed & 1p Sales

Neew [ o Cances

d. Once criteria are set, click OK to start the extract.
e. Select Utilities > Job Queue: Job Queue Type ‘Comp Sales Extract’ to view Job Progress
- Lo fol®

| F
I Selected Jobx & job Queve Type: Flter By Operator Value
| ijpSllnE-trxt * | | Date ®| lu®aal

¥

Job Control | Job Progress |

{ l I Date User | Stahs Mesuige m [f
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Set Comparable Sales Criteria

1. Select Comps & Apportionment > Comparable Sales Criteria
2. Define the Comp Sales model.

a. Code: Model Code — Links to Comps & Apportionment > Assess Neighborhood Base Rates >
Comp Sale Type

b. Description: Description for code

c. Type: Indicates the property type associated with the model (Residential, Commercial,
Condo Unit, Condo Main)

d. Start Date: Minimum date for the range of sales used in the comp model
e. End Date: Maximum date for the range of sales used in the comp model

f. Threshold: Maximum allowable comparable point value. The comparable sales routine
assigns a point value to each comparable in relation to the subject property, based on the
user defined variables. Comparables that exceed the threshold are excluded. Comparables
with the lowest calculated point value are then used to calculate the value for the subject
property. (This uses the Minkowski Similarity Metric: I ({Weight,/Standard Deviationy) *
Abs(Subject Var, — Comp Vary))

g. Value Type: Indicates the method used to calculate the subject property’s Market Comp
Sales value. (Median, Average, Exclude Hi/Low, Weighted Average)

h. Value Source: Comparable property appraised value used to calculate the subject property
value.

i. Criteria (Not Visible): Inclusion criteria for filtering potential comparable properties. Enter a
valid SQL ‘where’ clause {without the ‘where’). Example: PARCEL.PRC_ASSNG_DIST IN
{‘0001°/0002')

Comparable Sabes Criteria
| Code Descnpt Type StatDate  EndDate Thieshold |Value Type | Value
# Documentation Residental = 01/01/2015-~+12/31/2016 =~ 100000 - Median < Cost

3. Set Comp Sales Model Variables — Click "</ to create new models, or | e o view/alter
existing models.

a. Comp Sale Variable Name Page

i. Variable Name: Name of specific model (no spaces allowed)
ii. Description: Description of variable
iii. Type: Identify the type of model
A. (B)inary — Converts database code to numeric value
B. {N)umeric — Database value
C. Match (E)xactly — Variable must match or comparable is excluded
D

. (O)BXF Group - Sum of units for OBXF Code(s); Enter a comma separated list of
codes to include in the codes / formula box (Next Page)

E. (S)ubarea — Sum of gross area for subarea code(s); Enter a comma separated list of
codes to include in the codes / formula box (Next Page)
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F. (D)istance — Computes the Euclidean distance between the subject parcel and the
comparable. Metric = Weight or StdDev * Distance (X,Y coordinates must be
populated on the Supplemental Data screen)

(Com Soa Viriibte NamnaBoge __Erl

e, it

IR P D T T TRTI7E e ISR P

et Is The Name OF Your Veriabis?

Variabhie Msve |

Description i

What I5 The Type OF Your Variable?

Type [ N mar

Yariabie Type Deec: Numavic: Comnpires the valie of » muisric Seld on 8 it %0 the weius of
the fealdl ow the 1whbjsct property. Ured for frlds Gk briding amas land swa or sflectoee yeur
Enaiit.

Cancel | | dvet > |

b. Comp Sale Database Field Page (if applicable)

i. Field: Select Table / Field for the model

Carn S Daeabave Feld Fage ' ]
What is The Database Field For Your Varable?
Fiela Darabase Feld Craer
DS = | | Appacation Fid Labwl ™
CONSTR

CONSTROEP
4 "] CONSTRRES ‘
£ BuldngUitraddd [ §
I Bulenguitabeste { |} |
1 ENE_AL_TYPG ( Air Canei tioweng §
P OMG_AC TYPE TH5C T ) |
| ONS_AD)_BASE RATE( )
) CHS_AREA_BFFECTIVE { Sitectve Assg § ‘
JEMS_AREA_GRUAS ()
| OIS _AMEA_LIVING | Livng Assa/GRA )
1" | CNG BASE_RATE { Base Nate ) -l

Soncet | | <ok | [Rewt» ]

c. Comp Sale Binary Page

i. Click the s | button to populate the grid with available codes for the data field
indicated

ii. Inthe Numeric Value column, enter the desired point value for each code. This value is
multiplied by the weight indicated on the Comp Sale Weight Page.
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Mﬁ = :' — re——— ﬂ |
Binary Page |
|
Cose Date Nomers Value |
A w |
As [ |
(] 0 - ‘

[+ 50 =
& 40 |

[} 30
Lance = Back ._El__-__|

d. Comp Sale Codes Formula Page (if applicable)

i. Select the desired Subarea or Qutbuilding codes for the model. Use a comma to
separate multiple codes.

Comn Sals Codes Formats Page dades P e

(€]
What s T Name OFf Your Vanable?
Codes/Formuls
RGA, RGS, RGO

ADV Aoty Ve -
APL  Fence - Chae

AP2 Eonce - Pt

apri Fenca - Stoceade

P2 Fence - Pext & Aad

apa Femce - skt Weave

Al Fance - Iron

ART Wall - Bewirwng

ki Dot =oute - 351

BhH2 Boat House - 2 51

s . Oaafidealetada. . oo o S e ———

| goncel | | < Back | | tyeet »

e. Comp Sale Weight Page (if applicable)

i. Enter Weight OR Standard Deviation

A. Weight: Points applied for the variable

B. Standard Deviation (Numeric Only — Click the | €2 | putton to calculate the value
from the database)
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Com Bals Wight Page ' P — i a
(€

Emar Weight and Sis Dev

Weight 100

St Dee 1 {Cox |

Lt Corfee 0

Lancel Back | Jemst »

f. Comp Sale Summary Page
i. Review the model details
ii. Click '™ to complete the model

g. Once models are complete, click * in the lower right corner of the screen.

4. Create Extract
a. Select the desired model in the top pane of the Comparable Sales Criteria page
b. Click |“=s=tmma 3¢ the bottom of the page.
¢. The screen will show “Loading, please wait....”

d. Upon completion, the screen will display the number of parcels included in the data
extract. This extract is later used to assign comparables to subject properties.

{Create Extract] 701 parcels in the extract.

5. Assign Comp Model to Assessing Neighborhood(s)

a. Select Comps & Apportionment > Assess Neighborhood Base Rates

Comps & Apportionment b
Comps & Apportionment
Saie Trending Factors
Comparzbie Sales Criteria

Assess Neighborhood Base Rates
Run Trending & Apportionment

b. Select the appropriate model in the Building Type pane.
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Assessing Neighborhoods

Building Type

Code Descnption
00 Vacamt
P 0L Residental
42  Mobile Fome
Multi-Famivy

2

Londo Main
Res Condo
Com Condo
Comm/lnd

Sve Shp/Gar

£ 8 £ 8 2€F

Ind/Corum

c. Inthe right pane, enter the desired Comparable Sale Code in the Comp Sale Type column
for each neighborhood.

Freez Cost Trer .amp Sais
il ode ' Description - Cost Moded Cost Trend | Sale » R
Values ‘ Ady Trending Type

. - ——
B 00! Mahopac Readenvat MOLO1 -~ 1000 DCCS - VL Y
" 0002 Carmet Residential 3MOL 01 - 1000 OoCcC - Wi

P ]

d. Once Comparable Sale codes are set, click “**in the lower right corner of the screen.

Calculate Comparable Sales Values for a Parcel

1. While in the subject parcel select Parcel > Comparables > Comp Sales Detail

Vision 8 Application Explorer -~ - w B X
Parcel
Legal Information
Classification & Land Information
Building Information
Outbuildings
Gis
Comparables

o oK &K &« «

2. Click el
3. The grid will display up to five comparable sales for the subject property.

4. The Comp Model, Value Type and Comp Final Value will display beneath the Parcel Information
Header.
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| Comparable Sules Detall Modet R3-Residential 3 Vahue Type: Median Comp Final Vialae: 337,000

Run) [Custom) [Put]  un Dote: 3/2/2017

5. To review and/or change selected comps, click ==l

a. Agrid will appear displaying comparable sale properties within the threshold.

* Curtamized Lomgeaman Seiv

Parcal Locmon | Use Code NBHD ‘Saits Date | Sale Price
~ 4657 50 Upper Laie 3d 210 o0% Y1015 137000
< 75475 Zi 'West Dr 210 et RIS YA GE] 300
< a6 P5 Craatrnrl Rage Rzl 10 LH P H L5828 513 263000
¥ M &3 Adeiom Oval e 0901 2% 018 236,000
< 55113 35 Mesdow Ro 210 LEE 237018 243 700
14557 133 Longdade Rai ne 00 R ety 335000
A4S A3 Lakw Dr pinl Lru 41206 o0
M7 301 Woad Rd 210 [Ev s WITIMLA X0 000

b. To modify the comparables used to value the subject property, de-select the undesired
properties, and select alternate properties from the list. The software allows a maximum of
five comparable sales. (Note: Double-click the checkbox to select or de-select a property)

c. Once complete, click o 1o exit.

d. From the Comp Sales Detail screen, click ) to calculate the Comp Final Value using the
custom comparables.

e. To view a summary of the selected comparables with their primary photo select Parcel >
Comparables > Comp Sales Photo

Parcel

Legal Information

Classification & Land Information
Building Information
Outbulldings

Gis

Comparables
Comp Saies Pnoto
Comp Sa‘es Detail

» o U4 o « &«

6. To select the Comparable Sales value as your final value for the parcel, select Parcel > Legal
Information > Assessment History. Set the Value Source to M: Market Comps

Ampepnerd Sommary

Vase  Date  Snats | Sebected Vatso Apgeatunt At
[[em——, 10 UM € |Tom Appraned Buig $207 0 257 70
Mudat Comp Selus ST 000 WI/XRY 4 Tads) Appraned fatya Fasture 10 f0
Comp Appertionment -] € | Tadak Appramed Outiidg ] ®
Tow Agputormans w e Apge sned Lanid $109 M0 4129 X0
Pome %© Ve (4 Tors Vabae 207,000 112,000
gl HoeA00 WY C

]

Marhal & Sl Cont % o N e i B

Vo Smmroe A& Maeket Compy
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Calculate Comparable Sales Values for a Group
of Parcels

1. Select Utilities > Recalc Parcels > Recalc Selected Parcels

2. In the Schedule Options, de-select all Recalculation Methods, then select Run Comparable Sales.

Indicate whether the job should be Run Now or Run Later. Then click 'Sehsdue],

|+ Recwcution khedlng =]
Schesude Optiom |
Recatoulaton Methods Recaloulation Schedule |[
Recaleulate Lang Values 0 Bup Now |
Recalouiste Improvements O fun Lodey
[ Recaicutate Cost Buiing Values P Ol {
7} Recalosinse Outbuwiding and Bara Fenture Vil . il
; 619 AM &
173 Recalutate tacome Valves |
7 Relresn Parcet Total Recurente Once
; Rezaloutnte w“s‘!m D'llﬁ‘l
[# Run Comparstle Sates Wieeety i
I Run Yalus Trendmg Monthly |
@ Disabled |
|
|
Comcel| |Schedule
|

3. Indicate the filter criteria and click Ok to start the comparable sales calculation.

- Custom Pucal Taarch o |
Range U Parcais Panel Stlective | Advanced | Range Cf MBLL !
Parcel Selection Active x
A courd N bee Foraen Te
e Kopan e
Location Frtan Ta
Saneis Name From Te
Date Duscel Last Modified From Te
Bag HEBHD E
Comen N2=D) -
Congo MBidD = |
Soe -
| Wlodat . n
Primary Use = !
| User Type -
s | w!
w!
- f_‘j ‘-;:; hen t
Use Code |
= = v
Sate Dute Frm | e |
P bnchydle Usquesfies Salns?
b Qualified & 1p Selez
Hew \ O LCancel

4. Select Utilities > Job Queue: Job Queue Type ‘Recalculate Parcels’ to view Job Progress
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Selected job: -} Job Queue Type Fitter 8y: Operptor.  Valve
|Recakulate Pacceis *|[Date || =

Job Control | Job Progress

10 Date iser Status Message

5. Once complete, calculated values can be accessed either via creating a report in the Report Wizard,
or by viewing individual parcels.

© 20189 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: How to Recalc Marshall & Swift Values

) VISION

NM N

How to Recalculate Marshall & Swift
Values

This document outlines the process to recalculate Marshall & Swift Values in the Vision. This is a
two-step process. First, the software requires a Marshall and Swift recalc to populate the MVP
generated values in Vision. Second, a full recalc is required to integrate the MVP values into the
Vision valuation engine.

1. Open the Vision CAMA application.

2. Select Utilities > Recalc Parcels > Recalc Select Parcels

[ Foe Carcs |Wiilies| teolp

L s
Recalc Parcels » Recale Cument Pyecel

Parcet Parcel Admirstration "

Cogal laforn Gtilities . Recals Select Parceis

Saies Arabais Utilities Recalc Reports ’
Comp Smapunot Utikber »
reome ates »
Mags Update "
Change Password

3. In Recalculation Scheduling, alter the Scheduling Options so that only the
Recalculate Land Values and Recalculate Marshall and Swift Values options are
selected, then click Schedule.
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Schedule Options

! Recokulate Land Vahses & Run Now

el R 2 Omw

) i i Run On: ! l

[7] Recalcutate Cost Bulding Values | At 755 oy e
[] Recalculate Outbuilding and Extra Feature Valuss
) Recalculate Income Vakoes Recurrence: ) Once
F) Refresh Parcel Totals Py
(¥} Recalculate Marshall and Swit Vahses N
[} Run Camparable Sales 1mn ,::,
7l v Vishre Yromctno -

| Cancel | | Schecuie |

4. Configure the Custom Parcel Search to target the required parcels, then click Ok.

Of Parcels | parce Sefective | Adanced | Range OF MBLL

! Parcet Setextion At 2l

Actount Number brom To

Fm Fram: Ts

Lacswon trom Te |

Crwnars Name From To

Dite Pazel Lot Modslied From o

Rt hitiivd | - |

Commen Kting ..__._ g ": R
| Condu Nohd e 2 - ‘;j
o = — , =

[T =

Primary Uive \ e ——— ' !

- ———— "
iL.miOnss Lt sy 2 :I
» e — I
| | ®: | Mamdihe

Use Code e —

R g ———— -
' Sale Dot From ; o iy
& Inchade Unaualfied Sohest
I Qi b 1p Sakes

5. To monitor the Job Progress for the Marshall & Swift recalc, navigate to Utilities >
Job Queue. Select Recalculate Parcels from the Job Queue Type. Then click
Refresh to update the Job Progress. Once the job is complete, proceed to the
next step.
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Selecred Job: . Job Queve Type: Fiver By: Operator  Value |

'Recakuiste Paccels = | Dute '| s
Job Progress | job Cantrl | - . | |
I | Date Uses | Statas Message
W 10/04 2018 0255 P ADMIN RUNMING  Processng (% complete

6. Repeat the above steps to run the second recalc, except alter the Scheduling
Options in the Recalculation Scheduling Settings. For this recalc, retain the
default recalculation settings.

( Raghicuane Land Volors 9 Run Now
L Recalcaiate improvenventy ) R Later
Bun On:| I
) Recalcutate Cost Bubding Viskses N s i -
[ Recalcutate Outbuilding and Exive Featurs Vakues
[¥) Recalcuiate Income Vakiee Recurrence: () Omes
(¥ Retresh Parced Tolsh ) Oy
I Recalculate Marshall ord Smdt \tokous ) Weekly
™) Mon Comparable Seles C Manihly
777 Mew Viadan Troowtones ® Ousbled

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Mass Update > Common Updates Using Mass Update

OVISION

IN V]

Common Updates Using Mass
Update

The Mass Update utility is a powerful tool. Make sure there is a valid database backup file created prior
to using this tool, as once the process is executed, changes cannot be reversed. Having a valid backup
file ensures that any changes can be reverted back to an older day’s status, if necessary. Contact
Customer Support if you need assistance with ensuring you have a valid database backup.

1. From the top-most menu bar, click on Utilities-Mass Update-Update Fields-
Common Updates

fle Cards | Utilities | Help

e
}.5 Job Queue BE
Recalc Parceis ’
Pacced Parce! Admiristration »
Tegal_lr:f-u_m“ Utities »
Sales Analysis Litilities 4
Comp Snapshat Utikities »
Income Utilitres ’
Mass Update » Insert >
Change Password Update Fields » Commen Updates
Advance Updates

2. The Mass Update Selection Parcels screen will pop up. From here, select an option:

¢ Advanced Search allows the user to create their own list of parcels to
update

= Existing Report indicates that a specific report contains the proper parcels to
be edited.
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P et

¢ GIS indicates the parcel information was gathered from the GIS module (this
option will only be populated if the GIS module is installed with the CAMA
system)

In this example, all parcels with a Primary Use of 100U: SFD — Urban Condo will be updated
to a new Land Zone.

3. Using Advanced Search, on the Range of Parcels tab in the Primary Use section
select 100U: SFD — Urban Condo and click OK.
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L R

-QH_Q@
Loimng keport

) G

Range Of Parcet et Semchve | Adwarces | Farge Of MU

A T
L3
Locason T
Qv e From o

Dove fascad Lamt Modifeq From To

e N0

Comen Nt

Conda Neg

Pyl -

L]

Prisnary Une 1 100U S0 - Ut Condo . S0, 0y

Use Type X

Class
3

e Cate P o (4)
W inchute Ungusified Sees?

[7] Chumtes & % Swles

4. Alist of parcels will appear in the Preview section below that qualify based upon the
selection entered along with a Parcel Count showing the number of targeted parcels.

ek, &

r— Paroes 1D Tape Vem Meone Vrrems
1 Futr
2 o .
) Falam
4 [
3 fane
& Fotant
7 Falpe
@ 18 3

Count 12 Cacel ' Mass Update|
5. Under the Land Attributes section, select the Zoning Drop box and choose ZB from
the list and click OK:
5 I o (et
Lawwd ATIATDA G : B Attiibnes Owerrides o Aljustenenty @
L] \ [Hective Year Built Oveeride Appristied Land Vet 1
Zoning ) Depeectution Code & Overtade Valun
bet  aamea Nk -0 Ot Aoranes
Cendition Factorl 78 20NEE. | | ahaE Source .
Sae e 2. 20N € | Funcional Obsol 1) Auid To Exbning
Liret Price e TOME D } Econoeic Dol [ ] Add To fmutng
JUTONE | ]
P IONEF
Proview G 2ONE G
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6. The list of parcels in the Preview section at the bottom of the screen will now display
the parcel information, including the new Zone code and a count of how many
parcels will be impacted by the change.

Preview

PID LND_NBHD 'LND_ZONE | LND_DSTR/

19 ZR

18 ZB 4

21 7B ,

20 ZB 2

Ll " -2

Count: 4 z
gt st mw B e et Pl S WS g P

7. Ifthe information appears as intended click the Mass Update button in the lower
right-hand section of the screen.

8. A notice will appear asking if you are sure you want to update the database with the
preview data. Choose Yes to apply the Mass Update
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9. When the update is done, a final message will appear.

0 Mass Update Completed

‘oxl

10. Click OK.

To confirm the change to the Zone was applied as intended, navigate to any of the
previously selected parcels and view the Classification and Land Information section. The

Building Classification and Land Line valuation screen should now show the ZONE as ZONE
B

Tudding Clasatfication And Land Line Valuation

o Wit Aeve HY " S
BRg® Line#® [Code Desomption Lirazsy Tyon Appriieead Astetted P Lon T Land Type D
L 1 100U SFD - Leban Condo 43560 SF $32.550:00 $33.60000 ZONE B
2 100U SFD - Usban Condo 20 AC $30.050 00 $30,30000 ZONE 8
tond Acms n Appraiged $62,680.00 | Emlioes |
A Loe
100U SFD - Usban Condo 100 R

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Mass Update > Advanced Updates Using Mass Update

OVISION

Advanced Updates Using Mass Update

The Mass Update utility is a powerful tool. Make sure there is a valid database backup file created prior to using this
tool, as once the process is executed, changes cannot be reversed. Having a valid backup file ensures that any changes
can be reverted back to an older day’s status, if necessary. Contact Customer Support if you need assistance with
ensuring you have a valid database backup.

1. From the top-most menu bar, click on Utilities-Mass Update-Update Fields-Advance Updates

File Cards [Utiliies]| Help

£ LY Job Queue EE;

soe § Appll Recalc Parceis 3
Parcel . Parcel Administration »
m Utilities »
Sales Anaiysis Utilities 3
Comp Snapshot Utilities »
Income Utilities »

Mass Update * I Insert >

Change Password Update Fields » Common JiGates

| Advance Updates

2. The Mass Update Selection Parcels screen will pop up. From here, select an option:

o Advanced Search allows the user to create their own list of parcels to update
¢ Existing Report indicates that a specific report contains the proper parcels to be edited.

e GIS indicates the parcel information was gathered from the GIS Module (this option will
only be populated if the GIS module is installed with the CAMA system)
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e e e e eee———
T

e = w%w*;:m-errﬂ_;*ﬁw%“f:ﬁ
Selection Parcels 2
© Advanced Search

() Existing Report

' Gis

p—

| Range Of Parcels | Parcel Selective | Advanced | Range Of MBLU

i Parcel Selection b\cﬁu g
|Account Number From |.- o To | — - ___!
| District From ] - (To | I
| Location From | - ) ) q_,.To | _ == |
Owners Name from | To| | "
Date Parcel Last Modified From l - : _fTO l - - |
Res NBHD I ESpPIp— —_'| ! = | = ) |
| Comm NBHD [—————————— I |
| Condo NBHD | - | . —
Style [_ - |
Model l - | ]
Building Class { o | |
Use Type |' —'] l |
Class [ 'J | |
! E s L |

L = I Mixed Use
Use Code = s . =

L - | < |
!Saeeoate From | - ol ]
‘ [#] Include Unqualified Sales?
l [_] Qualified & 1p Sales
"] Recak After Update
Advance Updates

'Ap_pl_icataon Field Label _ ) ) _ .

In this example, all parcels with a Primary Use of 100U: SFD — Urban Condo will be updated
by changing the PARCEL table, field PRCL_DESCRIPTION on ALL identified parcels to Vision
Documentation Project.

3. Using Selection Parcels: Advanced Search, on the Primary Use / Building Class section, select 210:
Single Family and click OK
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| Parcel | Actrve =

Setestion Pasceis
tmmc:@
Erstng Repert
[

Rongs Of Prcst Pascel Seectwe | Advnced | Range OVMBLU

Accoun From Ta
Datrct @ From To
From fo
Owners Name From To
Diate Parcel Lagt Modified Fiom e
Res NEHD = s =

Comm NEMD i .|

Congs NEHD ; |
Seyle . @ -
Modai o b '._'

Lozaton

- 1 Mied Ure
Use Code i

Saie Date From To

B Inctude Unguaided Seies? @
D Quaidied & 1p Sim

Recale After Update
Advande Updates
Appicaton Feld Label ol

4. A count of parcels will appear beneath the Preview section of the page that qualify based upon the
selection entered.

Table Name | Field Name | Value

Count: 8798

5. Under the Advance Updates section, scroll down to the PARCEL table and click on the drop arrow
¥ to display all associated PRC fields.

404



Advance Updates
;A Kcation Field Label

VRAD)

T PARCEL i
[} PRC_AGI_PGSF ( Aqgi Pgst) ’
{3 PRC_ALT_ACRES_TO_APPLY { AN Acres To Apply }
{"] PRC_ALT_APPROVED ( Alt Land Approved )
771 PRC_ALT_UOM ( Alt Unit Of Measure } g
1] PRC_ALT_UOM_TYPE [ Alt Unit Of Measure Type }
{T] PRC_APPORTN_ADI { Apportionment Adj }

PRC_APPORTN_DATE { Apportn Date }

6. The list of fields will appear. Scroll to the field PRC_DESCRIPTION and place a check in the left-hand
select box. This will add the field to the update section below.

Advance Updates

RS

| Application Field Label

|| PRC_DEPTH ( Depth )
PRC_DESCRIPTION ( Parcel Description )
EFFECTIVE_AREA ( Effective Area )

T N B T ok Sl B Yo S

_EXP_PGSF ( Exp Pgsf)
[ ] PRC_FRONTAGE ( Frontage )
[ ] PRC_GIS_AREA ( Gis Area )
~[] PRC_GIS_PERIMETER ( Gis Perimeter )
[ ] PRC_GIS_REGION ( Gis Region )
\ [ ] PRC_GROSS_AREA { Gross Area )
! = o R e
Table Name  Field Name Value /
PARCEL  PRC_DESCRIPTION ;
s gs s /

‘_,.,,.]-: R e r,,..)-’* .,A,-""""'»”‘"""'

34

7. Double click in the value field to add the information required for the mass update of the
DESCRIPTION field.

Table Name Field Name Value
> PARCEL - PRC_DESCRIPTION| Vision Documentation Project

8. If the information appears as intended click the Mass Update button in the lower right-hand section
of the screen.
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Cancel Mass Update

I e —

\qu N e e TR T g N

t

9. Anotice will appear asking if you are sure you want to update the database with the preview data.
Choose Yes to apply the Mass Update.

e Are you sure you want to update database with preview data?

10. When the update is done, a final message will appear

0 Mass Update Completed

11. Click OK.

To confirm the change the Parcel Description was applied as intended, navigate to any of
the previously selected parcels and view the Supplemental Data section. The Parcel
Information screen should now show a Parcel Description of Vision Documentation
Project.

Entity
GisID 04200000010010010000 X Coordinate 694972.078° Y Coordinate 946189.418"

Parcel Description Vision Documentation Project Q

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 017489 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Mass Update > How to Add Notes Using Mass Update

OVISION

How to Add Notes Using Mass Update

The Mass Update utility is a powerful tool. Make sure there is a valid database backup file created prior to using this
tool, as once the process is executed, changes cannot be reversed. Having a valid backup file ensures that any changes
can be reverted back to an older day’s status, if necessary. Contact Customer Support if you need assistance with
ensuring you have a valid database backup.

1. In the Report module, from the top-most menu bar, click on Utilities--Mass Update-Insert-Notes

File Cards | Utilities | Help
ﬁ ! Job Queue ! EE '.a."-'-
Ap Recalc Parcels > |
Pasced ‘ Parcel Administration »
Legal Inforr| Utilities ’
Sales Analysis Utilities -
Comp Snapshot Utilities B
Income Utilities B
Mass Update ’ i Insert > i Notes
Change Password l Update Fields » Notice History
[ Visit History
‘ | Overrides And Adjustments
Classification & Land Information 2 | '

2. The Selection Parcels screen will pop up. From here, either select an option:

* Advanced Search allows the user to create their own list of parcels to update

= Existing Report indicates that a specific report contains the proper parcels to be edited.

¢ GIS indicates the parcel information was gathered from the GIS module (this option will only
be populated if the GIS module is installed with the CAMA system)
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In this example, all parcels with a Primary Use of 100U: SFD - Urban Condo will be
updated.

3. Using Advanced Search, on the Range of Parcels tab in the Primary Use section select 100U: SFD —
Urban Condo and click OK

Sasmctcn Paveety —— -
e O
]

Ry OF Prrety  (araal Semtinee | Achvmruond | Hange Of Wi, L

A vovr

Ao 2 To
[ fo

Wbl §onay T
crren bt
Prienary 0L W Ut O " OO T,
e ‘ }
Labe Dot 1o

4. Alist of parcels will appear in the Preview section below that qualify based upon the selection
entered along with a Parcel Count showing the number of targeted parcels.
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5. In the Notes section, select the Note Type from the drop-down box.

Notes - N
TYpe | REM: Remarks

7]
Year | COST: Cost Ladder um@ '
Note LND: Lang Note

OBXF- Qoxf Nole
OCST: Other Cost Ladder item
REM: Remarks

{73 Privata

6. Enter the Year and a Note for these parcels and click on the OK button again.

s Sty o T e ST e
= \”
LA - @

s L1

Mooy < Lamnpe nete ke Mast '-t\-ﬂ:il-

7. The Preview pane shows the Note applied to each parcel.

Breview $
Parcel ID Type Year MNote Prevate
4 REM 204 Sample note using Mass Update  True
5 REM 2014 Sampie note using Mass Update  True
6 REM 2014 Sample note using Mass Update  True
7 REM 2014 Sample note using Mass Update  True
18 REM 2014 Sample note using Mass Upaate  True
19 REM 2014 Sample note uting Mats Update  True
20 REM 2014 Samgle note usang Mass Update  Tiue
21 REM 2014 Sample note using Mass Update  True

8. If the information appears as intended click the Mass Update button in the lower right-hand section
of the screen.
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Cancel Mass Update

Sy

|
|
1,

9. A notice will appear asking if you are sure you want to update the database with the preview data.
Choose Yes to apply the Mass Update.

0 Are you sure you want to update database with preview data?

10. When the update is done, a final message will appear.

6 Mass Update Completed

oo |

11. Click OK to return to the Report module.

12. To confirm the Note was applied as intended, navigate to any of the previously selected parcels and
view the Property Notes section under the Legal Information heading.

13. Highlight the newly added Visit History line to see that it includes the information from the initial
update as a line entry, and a summary will display in the bottom of the pane.
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Parced Infarmation

MBLU: 100/ 7 20/ / 30/ { Primary Use; 100U Use Type:

Location: 20 N MIAIN ST ST W UNIT A Total Assesse $155,100 Land Acres:  0.00

Property Notes |
Type  Oesc Year  Note

> REM - © 2014 Sample Note using Mass Update
REM Remarks 2014 Building set back from the road

Type REM: Remarks “_— v

Yo 2014 E

Note Sample Note using Mass Update
I P L L SO

© 2019 Vision Government Solutions Inc, All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer

internal ID: 20
Private ! Date Created
01/01/2014

RET S

T~
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You are here: Mass Update > How to Add Notice History Using Mass Update

O VISION

How to Add Notice History Using Mass
Update

The Mass Update utility is a powerful tool. Make sure there is a valid database backup file created prior to using this
tool, as once the process is executed, changes cannot be reversed. Having a valid backup file ensures that any changes
can be reverted back to an older day’s status, if necessary. Contact Customer Support if you need assistance with
ensuring you have a valid database backup.

1. In the Report module, from the top-most menu bar, click on Utilities--Mass Update-Insert-Notice
History

File Cards |Utilities | Melp
:f,s Job Queue ' EE Al
Recalc Parcels »
inistrati
Parced Parcel Administration »
Legal Inforr Utilities »
Sales Analysis Utilities > |
Comp Snapshot Utilities ’ |
Income Utilities »
Mass Update » Insert 3 I No
Change Password Update Fields » Notice History
i ' ‘ Visit History
I | Overrides And Adjustments
Classification & Land Information &

2. The Selection Parcels screen will pop up. From here, select an option:

* Advanced Search allows the user to create their own list of parcels to update

¢ Existing Report indicates that a specific report contains the proper parcels to be edited.

e GIS indicates the parcel information was gathered from the GIS module (this this option will
only be populated if the GIS module is installed with the CAMA system)
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In this example, all parcels with a Primary Use of 100U: SFD — Urban Condo will be
updated.

3. Using Advanced Search, on the Primary Use section, select 100U: SFD — Urban Condo and click OK
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4. In the Preview section, a list of parcels will appear that qualify based upon the selection entered
including a Parcel Count of the total number of parcels targeted.
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5. In the Notice History section, enter the Fiscal Year to which the note will be applied, a Notice Date,
Notice Code, and Notice Type.

mm
Natice Code Notice Type .
2‘"‘ Fho Tr 01 Eﬂ GENR General Cormpandence ~ v

lumo Cade 'ﬂd BLKM: Bulk Ml 1
fwu a date 3) ¥ CAL Phooe Can 4
| cTm certied Mau

| EMAL: Errapil
| EXPAL Empress Mast
| FAX Fax
Count B | FEOX: Fedex
MESG: Prone Metsage b
| OTHR Dthver - Expiain In Commants
| MGLM: Reguiar Mali

UPS: Ups

6. Add a Comment, if necessary.

| Aol N S | L} e N
Gl ___ hoGme Code . hewoxe Prpm
W IHEH B3] GEne: Generat Commponence vl .
Swrpoeme (Jate — [ [
ol 4 aste m » v v
Commens;
JAdding 1avpie Notice Mukory entey

7. Click the upper OK box again.

. s . )
Notcs Himey @

FocsiYow  Noounlas  MetkeCode _., J=aType
Jot4 Toovtvzons I Gt st Commpedence wil| X
’ Responis Dute . ReigomeCote ; v Swawa
Sl ! 8 iTata @] - - -
Comenonin .
ey samphe Norice Hiitory entiy

8. The Preview pane shows the Notice History applied to each parcel.
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prm »
iV
]

PID  |Fiscal Yr Date Notice Code ' Notice Type  Response Date R

18 2014 10/23/2014 1200:00 AM GENR RGLM 3

192014 10/23/2014 1200:00 AM GENR RGLM ;

20 2014 10/23/2014 12:00:00 AM GENR RGLM /

212014 10/23/2014 12:00:00 AM GENR RGLM ;

el - ;
iy R e P e S e TS R R e e o o e ‘;.'

9. Should the Notice History appear as intended, click the Mass Update button in the lower right-hand
section of the screen.

Tt e N AN

N s T

Cancel Mass Update

Py oL PR r ———

=94

T

10. A notice will appear asking if you are sure you want to update the database with the preview data.
Choose Yes to apply the Mass Update

0 Are you sure you want to update database with preview data?

11. When the update is done, a final message will appear.

6 Mass Update Completed

12. Click OK to return to the Report module.

13. To confirm the Notice History was applied as intended, navigate to any of the previously selected
parcels and view the Notice History section. Highlight the newly added Notice History line to see
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that it includes the information from the initial update as a line entry, and a summary will display in

the bottom of the pane.

Notice Hatory
- an)! ’ :D& i Matae Cnﬂ-}rﬁr.-nn Couty Deucripition | Notice Wé_w.nw ]r Dese Revporue Date Beqponse c-xal‘lﬂntnh Su-u:mmim
212 06062013 DATA Data Mater BLKM Bk i} ACAL AD  DONE

> e 124004 GENR Gerenal Cosreaponaerce RGLM Reguter List

At Notice Histary | Deless Notice History,
Facal Yot Notice Dete  Mabce Code Notice Type
2014 [ 102412014 (3] cereir Generat comesandence ! G- Roguiar Mad
Faiporvie Dale . Respsonue Code hetunly Shatuy

Select 4 date

Commants
AJOINg sumple noce heatory

© 2019 vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Mass Update > How to Add Visit History Using Mass Update

OVISION

A
v

How to Add Visit History Using Mass
Update

The Mass Update utility is a powerful tool. Make sure there is a valid database backup file created prior to using this
tool, as once the process is executed, changes cannot be reversed. Having a valid backup file ensures that any changes
can be reverted back to an older day’s status, if necessary. Contact Customer Support if you need assistance with
ensuring you have a valid database backup.

1. In the Report module, from the top-most menu bar, click on Utilities--Mass Update-Insert-Visit
History

File Cards |Uhﬁ‘;| Help

C*a ‘ Job Queue | EE J.' >

Recalc Parcels »
Parcel Parcel Administration >
Legal Inforn Utilities » |
! Sales Analysis Utilities »
Comp Snapshot Utilities »
Income Utilities »
Mass Update > Insert » i
.I Change Password I Update Fields » ‘ N istory
i Visit History
i I Qverrides And Adjustments
I

Classification 8 Land Information 2

2. The Selection Parcels screen will pop up. From here, either select an option:

e Advanced Search allows the user to create their own list of parcels to update

= Existing Report indicates that a specific report contains the proper parcels to be edited.

e GIS indicates the parcel information was gathered from the GIS module (this this option will
only be populated if the GIS module is installed with the CAMA system
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In this example, all parcels with a Primary Use of 100U: SFD — Urban Condo will be
updated.

3. Using Advanced Search, on the Primary Use section, select 100U: SFD — Urban Condo and click OK
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4, Alist of parcels will appear in the Preview section below that qualify based upon the selection
entered along with a Parcel Count showing the number of targeted parcels.
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5. Select the required fields in the Visit History section drop-boxes.

e Date

¢ Purpose

¢ [nitials

e [nfo Source
® Result

Visk History

Dem | 1072372014 ) fis)| Pupose s visiT v
initials  AQ: Assessor Dﬂwr@g . |wlj indoSource : 1: Chmer @Q v
s o B S

6. Enter a Note for these parcels, if required, and click the OK button in the upper right-hand section of
the screen.

e e, N i m Y

e o Cances
Owe VA AIT @ {E Purpase NS VIRT =
mals | AC: Assesor Ofie - v WiGSewse 1 Owner -

Ramjtt |0t Owener Home »*!

Hots is-wbvn Weasory Mote Q"—}\D

7. The Preview pane shows the Visit History information that will be applied to each parcel.

Povsien
Parcsl i g 1D Oaw ety L fonm iy Sourcy L
WILe0e L0000 1 A ¥s o 1 ‘Sammpit VisA
WA 2014 K Ee s o Sampde vist
) A v n 1 Sampte Viset”
4 » v [l ) Samphe Viea
i A v o ' Sampse Vit
A 5 m Swmpir VisA
v 01 Sapmphe Vivt
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Lomt B ]

8. If the information appears as intended click the Mass Update button in the lower right-hand section
of the screen.
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Cancel Mass Update

e T gt ™

\‘\;\ B 2 e e o ]

-

i,

9. A notice will appear asking if you are sure you want to update the database with the preview data.
Choose Yes to apply the Mass Update.

e Are you sure you want to update database with preview data?

10. When the update is done, a final message will appear.

0 Mass Update Completed

11. Click OK to return to the Report module.

12. To confirm the Visit History was applied as intended, navigate to any of the previously selected
parcels and view the Visit History section under the Building Information heading.

13. Highlight the newly added Visit History line to see that it includes the information from the initial
update as a line entry, and a summary will display in the bottom of the pane.
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Visit Histary

Mans Result) Besult Dessriphhoe Pyipase Purpee Dascnigion Notos

P N0/24/2014 A0 01 . o Vs Sample Vit History mote
1 010172014 AO 00 Vs
ladd! {Deiete|

Details
Bidg 1 ;
Date | ;
Info Source 1 ~
Instals | a0 Assessor Qffice v

Line Num >
Restiit | (12 Dwner Home v
Purpose |y VisiT -

Notes | Samipte Visit Histiny nole

© 2019 Vision Government Solutions Inc, All Rights Reserved.
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You are here: Mass Update > How to Add Visit History Using Mass Update

OVISION

How to Add Visit History Using Mass
Update

The Mass Update utility is a powerful tool. Make sure there is a valid database backup file created prior to using this
tool, as once the process is executed, changes cannot be reversed. Having a valid backup file ensures that any changes
can be reverted back to an older day’s status, if necessary. Contact Customer Support if you need assistance with

ensuring you have a valid database backup.

1. In the Report module, from the top-most menu bar, click on Utilities--Mass Update-Insert-Visit
History

File Cards |Utilities| Help
F}a [ Job Queue DE .&:‘_-.
Recaic Parcels ’ .
Pascel | Parcel Administration 3
Legal Inforn Utilities »
! Sales Analysis Utilitias »
| Comp Snapshot Utilities S
Income Utilities »
Mass Update » ! Insert >
‘ Change Password Update Fields > N istory
Visit History

i Overrides And Adjustments
I

Classification & Land Information R

2. The Selection Parcels screen will pop up. From here, either select an option:

¢ Advanced Search allows the user to create their own list of parcels to update
« Existing Report indicates that a specific report contains the proper parcels to be edited.

* GIS indicates the parcel information was gathered from the GIS module (this this option will
only be populated if the GIS module is installed with the CAMA system
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In this example, all parcels with a Primary Use of 100U: SFD — Urban Condo will be
updated.

3. Using Advanced Search, on the Primary Use section, select 100U: SFD — Urban Condo and click OK
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4. Alist of parcels will appear in the Preview section below that qualify based upon the selection
entered along with a Parcel Count showing the number of targeted parcels.
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5. Select the required fields in the Visit History section drop-boxes.

e Date

e Purpose

¢ Initials

¢ |Info Source
® Result

Viekt History

Ome o204 [ Pumose  yovigy -
nitials  AO: Assessor (Nfbcem . [wii info Sowce | - Crwnes @@ ~
Result  01; Owner Home @v@ v %

- e

e ; =4

S S ey

6. Enter a Note for these parcels, if required, and click the OK button in the upper right-hand section of
the screen.

L On Lorew
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7. The Preview pane shows the Visit History information that will be applied to each parcel.

=
3
=R

Coues | Concet |9

8. If the information appears as intended click the Mass Update button in the lower right-hand section
of the screen.
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Cancel Mass Update
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‘\( [ O RS Tl o R PR

g -

9. A notice will appear asking if you are sure you want to update the database with the preview data.
Choose Yes to apply the Mass Update.

e Are you sure you want to update database with preview data?

10. When the update is done, a final message will appear.

a Mass Update Completed

; 0K|

11. Click OK to return to the Report module.

12. To confirm the Visit History was applied as intended, navigate to any of the previously selected
parcels and view the Visit History section under the Building Information heading.

13. Highlight the newly added Visit History line to see that it includes the information from the initial
update as a line entry, and a summary wili display in the bottom of the pane.
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You are here: Extracts > Y2K Extract — Real Estate

OVISION

GOVERNMENT SOLUTIONS

Y2K Extract — Real Estate

The purpose of this document is to assist the user in generating an export of the database in the Y2K format. The Y2K format is Vision’s
standard billing extract. There are two versions of the Y2K extract, one for Real Estate and another for Personal Property. These

instructions are for running the Y2K Real Estate extract.

Please ensure the path C:\Vision8\LogFiles exists and the Windows’ user account has full
read/write access. The extract will fail if the path is not available, create the folder if it is
not present and confirm permissions are set appropriately.

1. Please ensure all other users are logged out the database before beginning the Y2K extract. Users should remain
logged out for the duration of the extract

2. To begin, log into the database on which you wish to run the Y2K extract.

CAMA System : Version 8

Computer Assisted Mass Appraisal
Environment : Conversion -
Connect To ' ANYTOWN_US >
User Name  USERMNAME

password saevsses

]I Log In ]| Cancel

VISION

GOVERNMENT SOLUTIONS ™

This producs is protected by copyright aws Any ditdeswre o distribution of
thie software without the written consent of Yision Govervment Soéutians will
& violation of the Soft Lcense Agraement

Budd version: B

3. For the Y2K Real Estate Data Extract select Utilities, Utilities, Standard Extracts, then Y2K Real Estate Extract.
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Job Queue

Recalc Parcels

el Administration

Lot nfors (_Utites)
| Sales Analysis Utilities
Comp Snapshot Utilities
Income Utilibes
Mass Update

! Change Password

Classification & Land Information® ||

Building Information £

Outbuildings

» 1 Recycle Bin Functionality

’ Copy Exemptions

» Change Unit Prices {3, Ac, Etc)

3 Make Futuse Sates Mistory

’ Make All Future Sales Current
Make All Future Parcels Active

Update Cost Model Binaries
Clear Betterments

Clear Betterments By Year

Clear Growth

: Save Assessment History
Assessment History Line Rernoval

; Standard Imports
: Custom Extracts
| Custom Import

%’fi The Y2K Real Estate extract screen will appear.

-
o

format  Real Estate

Export Records that

changed on or after el E
Destination File Directory:  c:\Vision8
Split Acreage
Exclude Condo Main

Exclude Work In Progress

(Run [cance

4, The Export Records that changed on or after section allows the user to only include those parcels with a modified

Y2K Real Estate
Y2kPersoni_Property_Subl
¥Y2K Personl Property
Multi Ownership Export
Warren Group Extract

date equal to or greater than the date entered. Leave this field blank to select ALL parcels.

You may either enter a date in the mm/dd/yyyy format or click on the calendar icon @
and select the date by navigating to the month and clicking the day concerned.



Format  Real Estate
|
Recordsthat [ -0 o =
Export B/6/2015 o)) :

changed onarafer " L=
4 Janmasy, 2016 »
Destination File Directory:
Su Mo Tu We Th Fr Sa
SplitAcrelge 27 28 29 30 3 12
[7] Exclude Condo Main 3 4 5 6 7 8 9 |

@ Exclude WorkIn Progress| 10 12 12 13 14 15 16

171819 0 2 2 3
#2526 27 28 » 10 el
#1203 o2 5 65 el

Once the date is selected it will fill the date in the date field

Format:

Export Records that
changed on or after:

Destination File Directory:  c:\Vision8 Iﬂrwm!
Split Acreage

[#] Exclude Condo Main
Exclude Work In Progress

[Run] [Cancel

5. The Destination File Directory is the location to which the resulting extract and layout files will be written. The
default directory is C:\Vision8.

2% To change the location the files will be written to, you may either type the path manually in
the Destination File Directory or use the Browse button to select a location.

Export Records that [ 1/1/2016

changed on or after
Destination File Directory: ' c\Visiond]
Split Acreage
Exclude Conda Main
@] Exclude Work In Progress
(Run| |Cancel
f, If using the Browse For Folder, first select the folder and then select OK.
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4 %, Local Disk (C)
AV

D ALL Secure Virtual Assist

IMAGES
inetpub
Intel

Inhic inctall

The desired path will be populated in the Destination File Directory field.

PR

Q YIK_REAL ESTATE (o l'@ |8

Format:  Real Estate

Beport Recordsthat [, 016 ) !

changed on oraften .

Destination File Directory:  c\Extracts iBmwse]

] split Acreage
{#! Exclude Condo Main
[¥] Exclude Wark In Progress

[Run) [Cancel

6. The last step before beginning the extract is to review the options in the two checkboxes. To select either option,
click in the box for the selection concerned.

> Checking Split Acreage will result in values for each land line being separated in the extract.
o Checking Exclude Condo Main will cause the extract to omit all Condo Main parcels.

o Checking Exclude Work In Progress will cause the extract to omit all parcels flagged as work in progress on
the Supplemental Data screen.

Please check with your billing software vendor’s Y2K import procedures to confirm if either
should be selected.

7. Once all above steps are complete, select Run to begin the extract process.
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changed on or after: ek .

Destination File Directory:  c\Visiong| Browse|
I”| Split Acreage
¥] Exclude Condo Main . '
9 Exciude Work In Progress ]
|

A notification will appear confirming the job is now running. Click OK to close the window.

This job will now run in a separate thread, For progress updates please
check the job queue or PROGRESS table or the log files.

8. To check the status of the export, select Utilities then Job Queue.

1

-
~ o | B

i ar » | ;
i Parc ion [
i Utilities [
Sales Analysis Utilities L4 f

Comp Snapshot Utilities » },

Change Password 4
e

=) 7

PRSPPI | | S e

'~ The Job Queue screen will open.
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Selected Job: job Queue Type: Fdter By: Operator: Vale: ]
[ Report viioae v = =
Job Controt ; job Progress ; ‘
R T R PY PR | |
H e
View L0 H Han Jobs Stop Job Uptlate Schedie l Retresh —J

Job and Schedule Details 2

9. To check the status of the extract, click the drop down under Job Queue Type and select Y2K Real Estate.

lob Queve Type: ) Operator:  Value:

[Repon

Job Contiol job Progress | | Apply Changes from Sales into Master

D Type  Status ICompSMesEmm Next Run {ast Run
Carmyg Sale Rate Tabie
Sabes Analyss Exiract
| Sates Analysss Rate Table
Sate Trending
Appomonment

#Rncakulue Parcels

— - e 'y
YK Rea! Estate T =
View Log Rl 2K Persont Propeny e [ R

Job snd Schedule Details L]

10. Next select the Job Progress tab and click the Refresh button.

Setected Job: .y ) Job Queue Type: Filies By Operatar  Vale
1 ¥2K Reat Estate « Date v = v

Job Cantrol - Job Progress

ID Date Uses: Siatus Mesage
shier L) Run ot Sy B g birte Sechedule i Refresh i
Job ang S<hedule Detaits L

11. The current extract job will appear on the top line of the Job queue.
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Selected Job: 2 job Queus Type: filter By: Operatar:  Value: 9
. V2K Real Estate ~. Date - n v
Job Control | Job Piogress E
1D Date ‘Uagr | Stanhss ‘Message
422 02M2/2015 0223 PV ADMIN QUNNING 20 RECORDS QUT OF 2,525 PROCESSED l
421 G2M027015 1146 AM ADM:iN COMPLETE Please consult the log fée Y2KV/ _Realfsiate_log.t
A28 QRAAAIN15 1602 AM ADMIN COMPLETE Please consult the log fike Y2KV?_Realtsiate_log.nat >
419 922015 0313 AN ADMIN COMPLETE Please consut the log fde YIKVT Reallstate log ixt r
A1 01/3072018 1037 AM ADMIN COMPLETE Please zonsiat the log e YIKV? RealEstate_log tat
I ¥
Viow i rg Rl Joks Stop b Update Seheduln Refresh L
e —
Job snd Schedule Details [ F

¥ - . - &

12. While the extract is running, you may click refresh as often as a status update of the job is desired. Please
remember to keep all other users out of the database while the process continues to run.

Selacted Job: . ob Queus Type: Fiter 8y Operator  Vakue:
¥2K Rea) Estate v  Date v = =
Job Conwral  lob Priogress 5y
D Dote User  Status Message
A22 OS5 0241 PM ADMIN RUNNING 2,040 RECORDS Ot OF 2 525 PROCESSED.
421 DA0Z2015 1146 AM ADMIN COMIMETE Plevse consult the Sog fie Y2KV7_Realfsiate long it i
420 02022015 1002 AM  ADMIN COMPLETE Medse consult 1he bog e Y2KYT Realéstate jog rt f
413 020250511 AN ADMIN COMPLETE Please consult the log fke Y2Kv7 RealEstate_iog txt i
418 01/30/2015 1037 AM ADMIN COMPLETE Please conauit the log file Y2Kv7_Reaifsl H
= |
Wi 1) S lads Hrag iy Updnde Sehe<iine | i =
Job and Schegtule Detslls 7 . i AR

13. When the Y2K Extract has completed, the Job Scheduler will have a Status of Complete and a message stating
Please consult the log file Y2KV8_RealEstate_log.txt. At this point other users may log back in to the database
without issue.

Sefected ol . ot Queue Type Fitet By Operatar  Vafue:
Y2X Real Extate ~ Date ~ G ’

Job Conral  Job Progiess }

0 Date iUser  Status Message

422 02/02/2015 D247 PM ADRMIN COMPIETE Please oonsidl the log fike YZKV7_Realfstate log it

421 {2;02/2015 11:46 AN ADMHN COMPLETE Plegse considt the kg fie YZKVT_RealEslate_iog bt l

420 02/02/2015 W02 AM ADMIN COMPLETE Please consuat the bog file Y2KV7_RealEstane_log.tul

419 D0272005 0013 AW ADMIN COMPLETE Piease consutt the bog fike Y2KV7_Realfstate ing bt

418 017302015 10:37 AWt ARMIN COMPLETE Please considt the log fike YKVT _RealEstate_log.txl

View Log Ruirt Jots Stop Ml Upsate Shed e I Rafrash

Job and Schedule Details .

14. To review the error log, navigate to C:\Vision8\Logfiles. Open the text document Y2KV8_RealEstate_log.txt,
confirm the correct number of parcels extracted and that no errors were recorded.

434



Hesuo Sidfe -

©
HRpit &
horasel_imstak

S chees

TEMP

Tamrs

Hare

> o= e B

FRVT Masilxtate jog oo

[_J & ‘I L x !1, ‘ £ v ai + A e - s
‘\ BeCopy pam P gany seiann s ‘1 Sem Swect romme
Crgy Mo Cop D-hu Ransme Frupartey

(Rl o oy rmm VT emary g et mletan

- o e <KD “iG i

[iate s s Twe I

75247 W Tput Do armend e

2

15. Open the text document Y2KV8_RealEstate_log.txt, confirm the correct number of parcels extracted and that no

errors were recorded.

File Edit Formrmat View Help

Export 1d:

Export Name:

File Name:

File Location:

Use Impersonatlion:
Start time:
Progress Table Job ID:
Records to Export:
EXport Name:
Export Hame:
Export Hame:
Export Hame:
Export Hawe:
Export Kame:

End time:
Records Exported:

SWMARY

1000

Y2K Real Estate
YIKV7_RealEstate. txt
C:\vision7

4o

92/02/2015 14:29
422

2,525

Owner of Record
Sales History
Exemptions

0ther Assessments
ASSESSED VALUES
Current Owner

82/02/2015% 14:47
2,525

EABEB UG A I CR R KIS FEITARFR ORI AR TN AKT RS KD EENETFAIAANNEN

The number ot records processed is correct.
There were no errors recorded during the extract process.

16. The extract file can be located in the base of the C:\Vision8 folder. Y2KV8_RealEstate.txt is the extract file to
provide to billing software vendor for import.

: _J X b TR O Y T T e
B Caprsith y; p Py it “ A e nome
g Laism Pasome Vi Hasatts:
= i W [ A P
v o
o] o
A ihviwtal e
b ey
| Lo 1] N
i1 Ad, AN
e —
i NP7 i sinie Wt N it ond D L ni
Temrn
YINT FUAE w5 aveas b1 ’ ot Five.
A by
b OWES
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17. The Y2KV8_RealEstate_Layout.txt file is the data layout format of the Y2K information which also lists the total

number of parcels and land/building/total values exported.

Yimmy shary i

; —J £cw l l o x I }g 4 bgm e ¢ o) Cyan + B soest
!ﬂ " Rt Comy paf h s LA R T J 7 e .
Copy Wove Cepy  Delewe Renaine  Yaew Prigerten
= v W . Fakdar . ® Metary
§r f [
« St kb TRPC ) Local Dk (T 5 Vision? “
o Neae ol wod e >
iy Thes bt 5. Logfies
1l S Ay AM
i Desidop
b u RCTT » s Rl
£ Dovumerdy ”
e o YVEKVT feaitstate ba WAL T
DA,
: o YIENT FeaZitete_Lpout ol LN AT
I3
L Pchures
B Voo

1. Open the text Y2KV8_RealEstate_Layout.txt, confirm the correct number of parcels extracted and that the total

land, building, and grand total values are as expected.

File Edt lofmat Wew Hatp

¥iK Real Extate (1122 BYFES)
ANYTOWN, WA

A E S F NN P U PR AR E NI R R AR P E PTG C PR T IR h RO N F B AN DTS RUAAAN R ANC IR UCARROZT AN ARG
output File: ta\vislun?\YIKV7_RealEstate. tut

Wusber of records: 2,525

total Land value 141,756,120
Total aldg value 311,959,773
Grand Toral 453,715,898

LRy Y N R T e e Ty T TP T YT TR Y YT

ACCOUNT THFORMATION (OCCURS I TI®L)

L R L L T Ly R T P P P P Y Py PP T YY)

map CHAR(A)
wap Cut CHAR( 1)
8lack CHAR{A)
#lock Cut CHAR( 1)

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01748 (800) 628-1013 www.vgsi.com
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You are here: Glossary

OVISION

Glossary

The Glossary terms are specific to Vision 8 Software only. The definitions in this glossary represent
very general representations of the associated terms. Many jurisdiction specific uses may not be
covered by the general definitions.

¢ Abatements
An Abatement is an amount deducted or subtracted from the assessed value. When a property
owner believes that their assessed value is incorrect, they may request an assessment review in
an Abatement process. The property owner first completes an Abatement Application requesting
a reduction in Parcel Assessment value. When an abatement application is processed the
Assessor’s office has the option to record specific information regarding the process in Vision.
The user should note that the Abatement screen is used to track information only. Any changes
in parcel assessment must be modified in the Valuation section of Vision.

¢ Actual Income
The Actual Income Section allows users to enter actual income, expense, and sale price data.
This data is gathered through a mailing of income and expense forms to all commercial,
industrial, and large apartment building owners in the jurisdiction. It is then qualified by an
experience commercial appraiser. The purpose of entering the data into this section is to be able
to summarize the information by utilizing reports located in the Income Report Section, thus
allowing users to gain a complete understanding of the Jurisdiction’s rental market. It is very
important that the economic accounts have been copied to the current year or added before
creating actual accounts.

¢ Adjustment Value
The Adjustment Value contains the adjustment factor for the parcel.

e Alternate Land Pricing Screen
The Alternate Land Pricing screen is available to provide an alternative way of attributing a value
to the land on a parcel. Some jurisdictions need to value properties on a Current Land Use Value
basis. The Use value is the assessment of the land for a specific purpose and is generally lower
than the market value. In Vision the market value is reflected on the Land Information and
Classification screen.

e Appraised Value
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Appraised value is the market value of the property. This value consists of an estimate of the
value of a property before application of any fractional assessment ratio, partial exemptions, or
other adjustments.

Assessed Value

Assessed value is the value of the property after fractional assessment ratios, partial exemptions,
and any decisions to override the market value of the property have been applied. The assessed
values are then provided to formulate the tax policy in a jurisdiction.

Assessment History

A record of the assessment values for each year. The Save Assessment Utility needs to be run in
order to save the values. Typically a new record is saved after the state certifies the year end
values.

Associated Parcels Screen

The Associated Parcel screen displays information about each associated parcel. Associated
parcels are used to combine two or more parcels that form one economic unit. Typically, these
are adjacent or nearby parcels owned by the same owner. One example is a shopping center
with an additional parking garage across the street. Rather than value the two parcels separately,
users can value them together on the primary parcel and then divide the total value into each
parcel. All valuation is done on the land and construction information for the primary parcel and
then distributed to any associated parcel(s) based on the percent of legal area they contain.

Book and Page
The book and page field is the reference or Deed number as registered in the county Registry of
Deeds.

Building Grade
Grade is a required entry and should reflect the design quality of the Improvement

Building Number
Because there can be numerous buildings on one lot, it is necessary to number the buildings.
This building number is also referred to in the land line section.

Building Permit

A permit is generally required for new construction, adding on to pre-existing structures, or
major renovations. Generally these construction projects must be inspected to ensure
compliance with regulations and to maintain accurate property records. The Building Permit
screen provides space to record that information.

Comparable Sales Valuation Approach

This application uses the Minkowski Similarity metric to determine comparable sales for parcels.
This method transforms the measures of absolute difference for diverse variables into directly
comparable numbers that can be added together into one metric. Parcels with the lowest scores
are selected as comparables.

Condition Factor

The condition factor provides the assessor/appraiser with the ability to adjust the land value in
such a way that unique land characteristics of a property that affect its value, in a positive or
negative manner, can be accounted for.

Cost Valuation Approach
The cost approach is based on the principle of substitution. Insofar as a rational informed
purchaser would pay no more for a property than the cost of building an acceptable substitute
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with like quality. The cost approach seeks to determine the replacement cost new of an
improvement minus the depreciation adding the land value.

Economic Income

The Economic Valuation section is where users may value a parcel using market based values.
These fields utilize tables that are built under the Income Tables Section after a careful income,
expense, vacancies, and capitalization rate analysis is performed by an appraiser.

Extra Features

Extra Features are items attached or added to the main structure such as mezzanines, fireplaces,
and saunas. Users may need jurisdictional guidelines to distinguish between what is an
outbuilding and what is an extra feature. However, extra features are typically attached to the
improvement.

Homestead/Farmstead

The Homestead/Farmstead screen works in accordance with the Pennsylvania "Homestead and
Farmstead Property Exclusion" program which may allow a real estate tax reduction. A
homestead is defined as a primary residence and a farmstead is defined as a primary residence
on a farm, including the value of building and structures used in commercial agricultural
production.

Land Neighborhood
Land neighborhood is for coding of major and sub-neighborhoods within a community. It can
take the place of the Site Index or be used in conjunction with the site index.

Land Use Codes

Each land line must be assigned a land use code. The first land line’s code should, but is not
required to, reflect the current primary use of the parcel. The Land Use Code chosen will
correlate to a Land Class for reporting purposes and for the classification of the parcel as
Residential, Commercial, Industrial, Exempt, Open Space or etc. This classification will drive the
land price curve based on the parcel’s primary use.

LERTA Exemptions

The Amortization Exemption screen allows the user to define and view a LERTA exemption
schedule. LERTA stands for Local Economic Revitalization Tax Assistance Law. Under the LERTA
program commercial property owners can receive a prorated ten year tax break on assessed
valuation of the improvements to a deteriorated business property from property tax increase if
they qualify.

Location
Information highlighting the nature of a property's location and immediate neighborhood.

Marshall and Swift Valuation Approach

The Marshall and Swift valuation approach uses the Square-Foot calculation. The Vision
application allows users to enter data in to the Marshall and Swift components screens which
then sends the data to the Marshall and Swift service (if configured in table maintenance) and
receive a value back based on the MVP calculation engine.

MBLU

The map, block, lot and unit numbers are the primary referencing system that make up the
parcel number. It is the means by which the system locates and identifies a specific parcel and
locates it on a map. It is essential that these numbers be entered in a consistent and accurate
fashion. Vision's system can accept a variety of numbering conventions. Once the numbering

439



system for your community is established, it must be carefully adhered to. In most cases, this
number will already be printed on the property record card.

Notice History Screen

The Notice History screen can be used to track correspondences with property owners. One Type
of Notice that might be recorded here would be an “Impact Notice.” An Impact Notice would be
mailed to the property owner indicating the new valuation on the property. Other batch mailings
or individual phone calls can also we recorded on this screen.

Other Assessments

Other Assessments, also known as Special Assessments or Betterments, are additional
assessments added to a parcel. The assessment of betterments is typically a method used to
recapture the cost of public improvements, which benefit a limited area, against the real estate
situated within that area. An example of another assessment is a public sewer hookup. Although
the owners of the real estate parcel are named in the assessment, they are not typically
personally liable for payment of the assessment. In Vision this field is used to track the other
assessments on the property. This information is not attributed to the total assessed value.

Outbuildings
Outbuilding items are typically detached from the main structure such as garages, pools, greens
houses, sheds, or fences.

Override Value
The Override Value is a dollar value of the override. Overrides can be applied to multiple
elements.

Parcel Address Screen

This screen contains a grid to create and maintain a list of alternate addresses for a property. The
first example is multiple legal mailing addresses for the parcel. When there is more than one
building on a parcel that might have separate mailing addresses users can enter those address
here. Having the alternate addresses allow for the user to search for other potential addresses to
find the subject property.

Personal Exemptions

Some jurisdictions may give property tax exemptions to some property owners as defined by
state law or local ordinance. An example of a personal exemption might be because the owner is
a veteran, surviving spouse, or a senior citizen. Because Exemptions are applied based on the
owner of the property users can enable a setting that will notify users that there is an exemption
on a parcel when users enter a new owner on that parcel.

PID

PID means Parcel Identification Number. This is a unique number automatically generated by the
database to identify a particular parcel. It is typically asked for when contacting Customer
Support for assistance on a parcel.

Pin Number

The PIN stands for Parcel Indentification Number. The PIN number section allows the
municipality to store a backup parcel number, or an actual PIN associated with a Geographic
Information System.

Property Note Screen

The Property Notes screen is a parcel level screen that allows users to track year and category
based notes. The notes in this section are limited to 2000 characters to prevent unmanaged
database growth. The property notes screen features a table driven type code and column
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header sorting. The notes grid will also contain a Date Create column that will track the date the
note was originally entered into Vision.

Qualified/Unqualified Sale
A qualified sale(Q) means it is an arms length sale. An unqualified (U) means that is it not a
normal market sale and should not be used in analysis.

Site Index
The site index can be used to rate land based on any type of characteristic.

Sketch

The Sketch shows the graphical representation of the building. The different sketched areas of a
building are called subareas. Subareas can be part of different sections of a building to account
for different depreciation rates of those sections. For example a new addition may have a
different depreciation rate than the original structure.

Street or Road
Type of betterments or improvements associated with the street on which the property is
located

Supplemental Data
The Supplemental Data screen contains user defined labels and data fields established based on
the needs of the jurisdiction. These fields are parcel level fields.

Topography
Information pertaining to the contour and/or the nature of the topographical features of land.

Utilities
Utilities available that service or have the potential to service the lot.

Vacant/Improved Sale
At time of whether the property is vacant or improved can be recorded in Vision.

Value Source
The Value Source field displays the valuation approach chosen from permitted values defined in
the Recalculation Settings table.

Visit History

The visit history allows users to keep track of actual visits to a property, hearing meetings, and
valuation reviews. After each visit users can enter notes about who went, what type of visit was
intended, what the result of the visit was, and who was spoken with during the visit. The Visit
History notes are linked to a building on a parcel. So if users have a shopping complex with 10
buildings and users are only able to visit 3 of them in one day, users can enter individual notes
for the separate building visits on that parcel.
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